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Summary 
 
The municipality of Rotterdam is responsible for keeping local roads free from snow and ice to keep 
vehicles and pedestrians safe while travelling. This responsibility is primarily the prevention from roads 
becoming slippery, whereby specialized vehicles are being used for spreading salt on roadways. The 
expenditures involved in winter road maintenances are notable and exceed the 3 million Euros for an 
average winter. To decrease costs the municipality of Rotterdam is looking for the possibility to 
optimize gritting routes by means of a vehicle routing model. A vehicle routing model determines a set 
of routes, each performed by a vehicle that starts and ends at its own depot, such that all road 
segments are serviced. It is possible that these vehicle routing models may outperform own manual 
drawn routes, which are currently used for routing gritting vehicles. The first stages of digitizing routes 
and recalculate routing is important in the increasing use of ICT in winter service management. 
 
The main research question of this thesis is: “To what extent can the adaptation of a routing model 
decrease the driving time of gritting vehicles in the municipality of Rotterdam?”. It must be noted that 
the main objective is not to endlessly optimize gritting routes, but rather to adopt a routing model 
within the municipal organisation of Rotterdam. Two contributes are made: (i) to formulate a process 
for acquiring, cleaning and manipulating network data, which are stored in a network dataset with 
network capabilities, and can be used as input for modelling gritting routes and (ii) to develop a process 
for generating, tweaking and adjusting a routing model, using a real network dataset based on driver 
distances. 
 
A review of routing characteristics in the organisation show that the winter service organisation take 
care of all gritting responsibilities. The gritting vehicles start from one of two depots in Rotterdam and 
have to, in poor weather conditions, service all roads subject to gritting in a two-hour time window 
one the vehicles leave the depot. The two-hour requirement is held even when weather conditions are 
better. Salt capacity on vehicles is however not seen a constraining factor. In the literature review 
these characteristics are also indicated to be relevant and additional characteristics are added 
regarding the road network. That is, that a graph representation of a transportation network with one-
way and two-way streets to be serviced and not every road segment traversed may need to be 
serviced. For the routing problem it is chosen to formulate it as a vehicle routing problem with a time-
window. The vehicle routing problem is widely used and integrated within most commercial GIS 
applications.  
 
A GIS routing model workflow is created with ESRI’s ArcGIS and used to recalculate two gritting routes 
of the Hoogvliet neighbourhood in Rotterdam. The GIS routing model consisted of thirteen phases. 
The routing model begins with a process for acquiring, cleaning and manipulation asset management 
network data, defined in data input and pre-processing stage of the GIS routing model workflow. At 
the core the routes are formulated using the vehicle routing solver of ArcGIS network analyst, which 
uses a meta-heuristic tabu search based algorithm. In the post-processing steps the route output is 
generated and the route reporting and route visualisations are made. The routing output is then 
generated and tweaked to represent arc traversals of winter service vehicles. In the routing model 
workflow, a possibility is added that some of the data input and parameters can be changed 
throughout the process. 
 
To test the model on the gritting routes of Hoogvliet, first the current routing is loaded into the model. 
The results compared to three scenarios. The first scenario is the new routing scenario. This scenario 
does not impose any restrictions on any of the two vehicles or the sequence of routing. The algorithm 
is set to find the most efficient routing based on total vehicle travel time. The result found is that the 
total travel time increased by 5.4% in comparison to the current routing. The sectoring scenario creates 
a categorisation of service roads based on administrative districting to create more compact routing. 
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The model run had an increase of total vehicle travel time of 8.4%. The last scenario is the node 
reduction scenario, in which nodes are reduced between two gritting route junctions to reduce 
complexity. The node reduction scenario did outperform the current gritting routes by 5.3% but did 
leave some arcs ungritted and unconnected inside the routing.  
 
The results shed light on the use of current GIS infrastructure to help in adopting a routing model for 
gritting vehicles. Although the routing model can be used to decrease driving time, it was tested at 
only two gritting roads in Hoogvliet. For implementation the routing calculations have to scale to 30 
main gritting routes. To implement some issues remain on both technical and organisational issues. 
The algorithm is not specially designed for large arc routing problems and has poor performance both 
in speed & accuracy. Districting is necessary to account for these issues. Furthermore, the network 
dataset cannot be simplified to reduce model solving complexity. From an organisation perspective, 
routing is labour intensive and quite specific. If one wants to proceed in recalculate the routing just 
once, one may want to consider these points before adopting a GIS routing model within the 
organisation.  
 
This thesis therefore makes four recommendations for adapting gritting routing within the municipality 
of Rotterdam. The first recommendation is to obtain or outsource the GIS software which is used to 
solve the formulated gritting routing problem. The current software which is available is not sufficient 
for solving large gritting routing problems. Secondly, it insists on the important notion that the routing 
must be closely created with the help of the winter service organisation. Route creation is an iterative 
process which require devoted attention by users. Thirdly, create a storage model for winter service 
asset management data and lastly make sure that the route creation is embedded in the organisation 
to ensure a sustainable routing solution. 
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1. Introduction 
 

1.1 Introduction 
Ever since the establishment of public snow removal services in the late 19th century, local 
governments are dealing with the removal of snow and ice from urban roadways to keep vehicles and 
pedestrians safe while travelling (Campbell & Langevin, 2000: p. 390). In those days man and horse-
powered vehicles were used to clear snow by putting it in their charts and dumping it in city rivers, 
lakes and sewer system. Later on, automobiles and trucks were increasingly used as they gained more 
prominence as a mode of transportation (Campbell & Langevin, 2000: p. 390). Today, municipalities in 
the Netherlands are still imposed with the task of keeping local roads and highways ramps accessible 
in winter. This responsibility is primarily the prevention from roads becoming slippery, whereby 
specialized vehicles are being used for spreading salt on roadways (Perrier et al., 2010).  
 
The expenditures involved in winter road maintenances are notable. Whereas it is only necessary to 
sprinkle salt a few times, infrastructural components like depots for vehicle and salt storage must be 
available throughout the year (Gerlagh, 1998). Furthermore, equipment like gritting vehicles and 
sprinkling systems are bought or rented. Together with employing personnel and fuel/salt usage, this 
leads to significant costs (Gerlagh, 1998). And on top indirect costs, like environmental degradation, 
economic losses and mobility reductions are posed upon society (Perrier et al., 2010; O’Keefe & Shi, 
2006). These indirect costs are thought to be several times larger than the direct costs involved (Nixon, 
2009).  
 
Municipalities are increasingly looking for ways to efficiently organise their salt spreading operations 
to save resources and minimize the environmental impact (Gerlagh, 1998; Perrier et al., 2010). A key 
theme in this field are the so-called ‘vehicle routing models’ (Perrier et al., 2007). A vehicle routing 
model consists of determining a set of routes, each performed by a vehicle that starts and ends at its 
own depot, such that all road segments are serviced, all the operational constraints are satisfied and 
the global costs are minimized (Perrier et al., 2007: p.215). Global costs for salt spreading are translated 
into objectives, such as minimize fleet size and a decrease of truck mileages (Xie et al., 2013; Perrier et 
al., 2007). However, the fleet size cannot be endlessly minimized due to basic operational constraints, 
including factors such as time windows, service levels and routing conditions.  
 
Whereby vehicle routing models focus on operational context such as minimizing fleet size and 
operation time of the current routing, there are also winter decision-making processes which are more 
or less linked to the routing of trucks (Hajibabai & Ouyang, 2016; Jang et al., 2010; Noble et al., 2006). 
The latter include both strategical decisions (i.e. depot location) and tactical decisions (i.e. sector 
design). Depot location is needed to know how many depots are needed and where to place them 
within the network. The sector design indicates which roadways must be serviced and which ones are 
not. Evaluating strategic, tactical and operational decision-making processes in an integrated way 
enables an even more refined route assessment (Jang et al., 2010; Noble et al., 2006).  

 
While the potential of vehicle routing is considerable, most municipalities still rely on hand-drafted 
maps based on field expertise instead to determine driving routes (Dowds, Novak & Scott, 2016; 
Hajibabai, 2014; Campbell & Langevin, 2000). The lack of implementing models could well be primarily 
due to the complexity of the operational environment (Bingham, 2008; Perrier et al., 2010). Differences 
in geographic location, weather conditions, legislatives, technological advancement and traffic 
regulations make it hard to adopt a generic approach (Perrier et al., 2010). Besides unique 
characterisations of the organisation comes into play. Local politicians may have a different view on 
strategic depot location decisions, fleet designing and deciding on operational constraints (Perrier et 
al., 2010). Decision-making for route optimization is thus a vigilant process which has to reckon with 
numerous and specific circumstances of both operation and organisation (Perrier et al., 2007). 
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To foster decision-making, the transportation sector is increasingly looking to Geographic Information 
Systems (GIS) for route optimization (Kuby et al., 2005; Fischer, 2004). GIS seems a promising 
technology which can overcome this ill-fit between the modelling of vehicle routing problem and its 
application for real-world problems (Keenan, 2008: p.202). Its strength is the possibility to create 
vehicle routing models and combine this with the ability to tweak settings and adjust routing outcomes 
manually. Facilitating this interaction between models and the skilled user can result in an effective 
decision support system (Keenan, 2008), but only if this fits the specifics of both the operational and 
organisational environment.  

 
The aim of this thesis is therefore set to close the implementation gap of adopting a gritting routing 
model for Dutch local governments to decrease driving time. To contribute to this issue, this thesis 
aspires to develop a routing model for Rotterdam with the use of a GIS.  
 

1.2 Problem statement 
With around 640.000 inhabitants Rotterdam is the second largest municipality of the Netherlands 
(Municipality of Rotterdam, 2018). The municipality has 990 kilometres of roadways and 630 
kilometres of bike lanes which are subject to gritting in winter times. These are divided into and 
serviced by 72 gritting routes (Municipality of Rotterdam, 2014). The winter maintenance division of 
the municipality of Rotterdam is responsible for the adequate handling of anti-slippery measurements 
during winter time. The executive team of this division consists of approximately 320 coordinators and 
members being standby 24/7 from November 1st till April 1st. As for the winter maintenance, for an 
average winter the operational costs exceed three million euros (Municipality of Rotterdam, 2014).  
 
To guide the routing process of gritting vehicles hand-drawn maps are used, which are updated once 
a year mainly according to driver feedback and planned road maintenances. The latest origin of the 
map routes is dated to 1970 to be the latest. From therefore onwards, new city routes have been 
added to the existing gritting routes as well as new ones were developed. While the routes work fine 
in practice, the winter team is increasingly aware of the possibilities of ICT technologies within the 
sector to make the work process more professional and efficient. 
 
During October 2016, the municipality of Rotterdam launched the project ‘WINTER’ to accompany this 
process of adding ICT applications to their gritting vehicles. Four main goals were formulated for the 
use of ICT applications, to achieve (i) an increase in the level of employer safety and other road users 
by adopting route guidance, (ii) more sustainable use of salt and less vehicle miles, (iii) a reduction of 
costs by decreasing man-hours while upholding the high service level and (iv) a diminished the pool of 
reserve drivers to decrease costs. To obtain these goals the deliverables of this project are partitioned 
into phases, from the digitalization of routes to the logging of the actual salt spread on roadways (table 
1.1).  
 
Table 1.1 Phasing project WINTER 
 

Phase Deliverables  

Phase 1 Digital availability of roadways and bike lanes which are subject to spreading 

Phase 2 Digital distillation of optimal routing for salt spreading 

Phase 3 Making the routing visible in the cabin of the gritting vehicles 

Phase 4 Salt spreading equipment is integrated with the routing software and visible in the cabin 

Phase 5 Routes are digitally logged and retrievable 

Phase 6 Insight into salt usage per route  

 
Within the municipality of Rotterdam the GIS advisory team is looked at to enable the project of 
coming up with solutions to recalculate routing. The focus here is on the first two phases: digital 
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availability of roadways and bike lanes and the digital distillation of optimal routing. These deliverables 
are essential and used as input for the upcoming phases of the WINTER project. 
 

1.3 Research relevance 
The modelling of gritting routes and the underlying routing models are quite familiar and have been 
well researched (see for overview studies Mourão & Pinto, 2017; Perrier et al., 2006a; Golden & Wong, 
1995). However, research did mostly address the formulation of mathematical models and appropriate 
heuristics for route optimization. What is researched to a lesser degree is how these models can be 
effectively applied within GIS systems and organisations. The publications on the development of GIS 
models (e.g. Keenan, 2001; Hajibabai, 2014; Krichen et al., 2014) did not share their models publicly 
and are not tailored to the specifics of routing problems (i.e. adding time windows). Therefore, these 
research outcomes have limited practical usage in this formulated problem. Instead, a routing 
workflow developed is built on top of commercially available routing models in GIS software, making 
it possible that the gathered data of asset management within GIS software can be used as input for 
routing solutions. It furthermore uses network data to formulate and evaluate routing outcomes. 
something that drastically increases practical applicability. Research of route optimization of gritting 
vehicles of the American Departments Of Transportation make little use of commercially available 
software, but rely on hand made routes or external route agencies instead (Dowds, Novak & Scott, 
2016). Developing a Dutch GIS framework for handling asset management data and develop routing 
solutions can help municipalities and other affiliated parties in developing automated routing solutions 
within the organisation. And in doing so, provide organisation effective routing tools for the planning 
of gritting routes. 
 

1.4 Research objectives 
The research objectives are divided into theoretical, empirical and practical objectives. These 
objectives are used as a guideline for drafting the research questions. The theoretical objectives are 
for exploring the underpinning concepts and literature, as well to help structure the concepts into an 
integral framework. The empirical objectives give direction for the data collection, processing and 
analyses. The practical objectives are merely used to implement the results.   
 

The first theoretical objective is to establish a knowledgebase about routing models and how these 
models can be used to decrease the driving time of gritting vehicles. This knowledgebase is twofold. 
First it describes the process from an organisational perspective. This concerns the current workflow 
of the winter service operations, as well as the different routing model requirements from the winter 
management team. The second theoretical objective is to link both the organisational and theoretical 
findings into a coherent framework, which can be used for designing the routing model. 
 
The empirical objective is providing a GIS routing workflow which enables to decrease driving times of  
gritting vehicles within the operational and organisational environment. The model should be further 
explored and validated to ensure a correct translation of situational characteristics.  
 
The practical objective is to advise on routing possibilities which decrease driving distances. Lastly, the 
procedure for calculating routing should be replicable within the organisation, in case when a revision 
is needed due to new roadway construction or organisational changes. 
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1.5 Research questions 

After defining the objectives of this study the following main research question has been formulated: 
 
To what extent can the adaptation of a routing model decrease the driving time of gritting vehicles 

in the municipality of Rotterdam? 
 
The main question contains two main concepts: routing model and driving time. As explained in the 
introduction the routing model is taken in an integral way. Not only will the routing be optimized within 
a GIS, but also factors like depot location and sector design will be incorporated into the routing model. 
This holistic approach to a, what often seems, a narrow scope of route reconfiguration allows 
managers to make a more sophisticated strategic and tactical decision-making. Driving time is here 
defined as the total sum of driving minutes of gritting vehicles. This goal is first and foremost reached 
by reducing dead mileage/minutes, i.e. vehicles that drive on roads which have already been serviced. 
Subsequently, other relevant factors will be manipulated in order to find a balance between decreasing 
driving time and other relevant factors, like the compactness of routes.  
 
To answer the main research question, five sub questions have been composed. The first sub question 
is designed to describe the current situation, whereby the next four sub questions are postulated based 
on the framework of Mitroff et al. (1974) on how to perform operational research based on 
quantitative modelling. The framework consists of four stages: conceptualisation, modelling, model 
solving and implementation. Each sub question respectively addresses one stage from the adopted 
framework. 
 

1    How is the current gritting of roads organised? 

First, a key objective is to get an understanding of the winter road maintenance organisation. What is 
the organisational structure of the winter gritting program and what is the decision-making process. 
Also, the current problems are described which can be used as input to elaborate on the system 
requirements for new routing. 
 

2    Which characteristics are considered relevant for modelling gritting routes? 

The second question deals with the conceptualisation for model routing. Which characteristics are 
used in routing models and which ones are considered relevant? Subsequently, different routing 
models and algorithmic solutions are examined which together construct the conceptual model.   
 

3    How can these characteristics be incorporated into a routing model? 

To answer this question a routing model workflow is developed which is capable to calculate routing 
based on the requirements which are set in the previous section.  
 

4   How does the routing model perform regarding the decrease of driving time? 

In question four the central theme is the performance of the model. This performance will be scenario 
based, in which each scenario reflects a strategic, tactical or operational decision. These scenarios are 
developed in close cooperation with the winter maintenance decision making team. 
 

5    To what extent can the GIS routing model be implemented within the organisation? 

This question gives an outlook to the implementation of outcome of the routing model and the 
different scenarios. To what extent can the results be used for reorganising gritting routes and what 
are the perceived effects of this reorganisation?  
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1.6 Research scope 
The research scope is to delimitate certain aspects related to the object of study. The object of study 
is stated in the main- and sub research questions, this will be examined. The following topics will not 
be examined: 
 

- This research only looks at salt spreading operations for winter service vehicles. Other 
operations snow hauling and manual labour are not considered. This does not imply that these 
operations are not performed within municipalities. During heavy snowfall these additional 
measures may take place but are outside the research scope. 

- Furthermore, this research will not propose new algorithms and/or (meta)heuristics for solving 
this routing problem, as it relies on current computational practices. This research also does 
not conduct a benchmark for algorithmic solutions, nor is it a quest for the most optimal 
pathfinding. The objective is rather to translate the operational and organizational context into 
a model which enables the municipality with more efficient routing.  

- This research is performed within the context of GIMA and the municipality of Rotterdam. A 
possible software solution will be within the limits of these organizations, respectively online 
available freeware. As a result, this software will more likely rely on a GIS infrastructure, rather 
than a mathematical software package. 

- This research is conducted within the larger ‘WINTER’ project. Currently, the municipality is 
also looking for cooperation with external parties to enable the transition of ICT within the 
winter maintenance operations. These external parties deliver software modules and onboard 
sensors which automatically adjust the salt level of salt spreaders for weather conditions. 
Therefore, the thesis is not concerned with adopting real-time weather information sources 
within the routing model.  

 

1.7 Contributions 
The main contribution of this thesis is the development of a routing model in a GIS, including: 
 

- A process for acquiring, cleaning and manipulating network data, which are stored in a 
network dataset with network capabilities, and can be used as input for modelling winter 
gritting. 

- A process for generating, tweaking and adjusting a routing model, using a real network dataset 
based on driver distances. 

 
The routing model will be tested in a real-life case of the municipality of Rotterdam. This ensures the 
fit of the model within the local context of a large-sized Dutch city.  
 

1.8 Thesis report structure  
The following chapters are structured as follows. Chapter 2 discusses the organisational framework 

within the municipality of Rotterdam. Chapter 3 provides a literature review about the salt spreading 

problem, different routing models and the implementation of these models within a GIS. At the end of 

the literature review the vehicle routing is synthesized in a conceptual model. The architecture of the 

routing model is presented in chapter 4. Chapter 5 analyses the results of the routing model, whereas 

chapter 6 discusses the possible implementation of the created model and suggests directions for 

further research. Chapter 7 contains the conclusion and provides policy recommendations. 
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2. The winter service section 
 

This chapter provides an overview of the organisational management of gritting within the 
municipality of Rotterdam. The introduction included two prepositioned explanations for the lack of 
implementing a routing model: the operational environment (such as differences in geographic 
location, weather conditions, legislatives, technological advancement and traffic regulations) and the 
organisational environment with respect to decision-making. Both operational and organisational 
environment will be explored and serves as a foundation for the development of a routing model which 
fits and fulfils the needs of the municipality.  
 
The chapter informs about the decision-making structure within the winter service section (section 
2.1). It is argued that the winter section can be represented as an organisation comparable to a Greek 
temple structure, with two pillars and a roof. The two pillars represent the departments of the winter 
service organisation and the road authority. To refine this model, both departments are separately 
dealt with in section 2.2 and 2.3. Subsequently, the activities of both parties congregate in the 
determination of the gritting routes (section 2.4). Within this section, both criteria for routing as well 
as updating are examined. In section 2.5 the roof of the temple is examined, in order to redefine the 
structure of determining gritting routes with the use of ICT. The chapter ends with concluding remarks 
in section 2.6. 
 

2.1 Winter road maintenance decision-making 
System design in winter road maintenance is a complex process of decision-making. Several 
departments are responsible for different activities which interact with each other, sometimes even 
on different levels. To enable these organisational structures within the decision-making process, 
these have to be structured. The organisation within the winter service section will be enfolded using 
two components: the management planning level and management decision problem structure. 
 
Management planning level 
Decision-making problems occur at a variety of management planning levels. Keenan (2001) and 
Perrier et al. (2010) structure decision making at three levels: strategic, tactical and operational.  
 

The strategic level in an organization defines the strategy, or direction, and decision-making 
process on the acquisition and allocation of its resources which last over a long time period 
(Perrier et al., 2007). This time span can range over an extended period of time, even years.  
 
The tactical level emphases on medium-term and short-term decisions which are reviewed once 
every few months (Perrier et al., 2007). For salt spreading, activities on this particular level usually 
take place just after the winter season ended and when tactical preparations take place for the 
next season.  
 
The operational level points at controlling activities on a day-to-day basis, like the assignment of 
staff to routes (Keenan, 2001; Perrier et al., 2010). The operational level also deals with 
operational risks, like sudden break-downs of equipment or change is weather forecast and 
requires an adequate response within a time interval of minutes. Real-time management is also 
considered to fall within this category (Perrier et al., 2010). 

 
Management decision problems  
The winter road maintenance falls within the category of logistical problems and operational 
research. In classical logistics functions, four groups have been identified (Gutiérrez & Vidal, 2013): 
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Network design deals with the management of the transportation network and the sectoring of 
roadways into districts. The location of depots is also considered to be part of this area of network 
design (facility location problem). 
 
Transportation management reflects transportation equipment, i.e. the need for specialized 
vehicles and equipment. The assignment of these vehicles to different parts of the transportation 
network fall within the responsibility of transportation management. 
 
Staff management deals with human resources. This concerns both drivers of winter gritting 
vehicles, as well as management and controlling personnel.  
 
Inventory control manages the stockpile and ensures it never will be empty. Primarily this implies 
both salt storage and replenishment. Both selections of suppliers and inventory policies are part 
of this inventory control.   

 
While decisions take place at different planning levels and management decision problems, these 
categories must not be looked at as deterministic, but rather as complementary categories (Perrier et 
al., 2006). Problems may be addressed at different levels; fleet assignment can be seen as a tactical 
decision, usually updated every winter season. However, in case of heavy snowfall readjustments can 
be required monthly, and therefore be considered to the operational level. 
 
There are numerous ways to incorporate decision making into an 
organisation. Traditionally each of the management decisions problems 
(i.e staffing) is strictly managed on different layers. Not the decision 
problem, but the duration and impact of a decision determines which 
body is responsible for the decision making. This corporate structure is 
denoted by a pyramid shaped model (figure 2.1). The pyramid symbolized 
the strategic level from the top all the way to the operational level on the 
bottom. While pyramid structures are successfully implemented in 
hierarchal organisations, coordination may be difficult between levels. As 
an example, if the network design adds new roadways without sufficient 
communication this affects the strategic location of the depot and may 
lead to an overuse and drawback in resources (Gutiérrez & Vidal, 2013).  
 
Instead, a more optimal model to organise resources could be a Greek 
temple structure. For this pillar structure many of the management 
decisions problems are taken within departments (pillars). Only at the 
strategic level, so at the top of the roof, different departments 
communicate (figure 2.1). 
 
The winter service section in Rotterdam has a tendency to follow the Greek temple structure. The core 
of this is located at the city management cluster (called: stadsbeheer). All tasks of transportation 
management, staff management and inventory control take place at this level. But network design falls 
within the responsibility of the road authority, being located within the cluster of city development 
(called: stadsontwikkeling). The roof of the temple represents the strategic collaborations between the 
different departments. For determining better routing, one could argue that the WINTER project team 
(as introduced in section 1.2) symbolizes the roof of the temple. Within WINTER members from various 
departments communicate to detect IT-driven solutions, amongst them optimized routing. Before the 
strategy will be deployed, the winter service organisation is introduced. 
 

Figure 2.1 The Pyramid and 
Greek temple; used to 
structure management levels. 
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2.2 The winter service organisation 
In the Netherlands three levels of organisational bodies exist: national, provincial and local 
governmental bodies. For the local body of Rotterdam the winter service management is published in 
the gritting policy plan (Beleidsplan Gladheidsbestrijding 2015-2020). These have been approved by 
both the mayor and municipal executives and act as a guideline for further policy implementation. The 
daily operations are explained in the implementation plan (Uitvoeringsplan Gladheidsbestrijding). 
 
The gritting team uses two main depot facilities, Giessenweg and Laagjes (term used to denounce the 
second depot at Karnisseland). Last summer, the Giessenweg depot has been renewed. The third depot 
at Hoogvliet is still closed for service during the upcoming year. All vehicles are scheduled to depart 
and arrive from the remaining two depots. Both Giessenweg and Laagjes depots are not scheduled to 
gritting only but are used for activities as vehicle storage for leaf sweepers as well.  
 
The core team is constituted of four separate teams, existing of 91 employees each. They can be called 
24/7 during the annual period of November 1st till April 1st (figure 2.2). These four teams work in shifts 
which alternate weekly are composed of 82 drivers, each assigned to predefined routes. It also includes 
eight executive winter coordinators, responsible for mobilising and leading the driver staff from the 
depots. The core team is led by a central coordinator. The central coordinator makes the final decision 
when salt spreading is needed, in which area and which quantity. And on top, the Executive Manager 
is assigned during the whole season of leading all four teams and ensures that all facilities are available 
and manages training to personnel. These consist of schedules, vehicles, training, communicates i.e. 
Most of the employees have different tasks for their city, e.g. in the areas of cleaning waste collection 
and management included, which fits in the seasonal character and dynamic nature of existing jobs at 
hand. 

 
 

 
Due to the seasonal and dynamic nature of the job, the teams are not working 24/7. In a season there 
are usually a few turnouts per team. At the beginning of the day, between 12:00-13:00, the central 
coordinator sends out a message containing the 24-hour weather forecast. This forecast contains a 

Figure 2.2 Organizational chart ice 
and snow control. On top the 
portfolio manager of the snow 
and ice control (orange), n blue 
the middle management of 
control functions and in black the 
operational forces of winter 
gritting vehicle drivers. 
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colour code, ranging from green (all OK) to red (switching to 12 hours driving service). This code 
indicates fairly if teams can be called upon during an upcoming period of time. 
 
Before the actual decision is taken to start spreading, different measurements took place. Rotterdam 
owns several measure stations, placed across the city and measuring different types of pavement (i.e. 
bridges, roadways, bike lanes, as well as some stations of surrounding municipalities). They are in close 
contact with Meteoconsult, which provides Rotterdam with weather information, delivered via an 
online platform. Based on these measurements, own experience and direct contact with a consultant 
from Meteoconsult, the decision whether to start spreading - or not - is made. When spreading is 
needed, the following sequence of actions take place (Municipality of Rotterdam, 2013: p.7): 
 

- Commanding. The central winter service coordinator makes the decision on which moment 
what gritting program will be activated. Choice is between only gritting critical infrastructure 
or a complete regular routing procedure (section 2.4 will supply more details about different 
programs and determination of routes). This choice is affected by the current weather 
situation and weather forecasts. Different programs mean different routing which are 
enabled, level of salt usage and use of extra equipment (i.e. shovels for snow ploughing). 
Instructions are communicated towards both executive winter coordinators and external 
contractors. Actions are logged within the internal system. 

- Command processing. The executive winter coordinators mobilise all personnel, subject to 
driving, and instruct them on salt usage and possible use of extra equipment. 

- Route driving. Within one hour after commands went out, gritting begins. Drivers are riding 
the predetermined routes, based on instructions given. Furthermore, the driver notes down 
both the correct starting and finish times of the entire route as well as potential liabilities. 

- Route control. The executive winter coordinators does control both time and liability input 
from all drivers. If defects occur to vehicles there will be taken notice of and implemented into 
the central system. Only thereafter the coordinator delivers administration forms. 

- Informing. Next, executive winter coordinators inform the central coordinator about the 
gritting process. The central coordinator at his turn checks the available area of salt and logs 
this into the systems. 

- Logging. The executive manager of the ’snow and ice program’ checks the logging and makes 
sure that the level of salt remains at a necessary and strategic level. If needed, he himself 
makes the call to have the salt delivered. 

 
This procedure is fixed, except when heavy snowfall occurs. When this happens, the team transits into 
a 12-hour service. This implies that two teams instead of one will drive the gritting routes, using 
rotating drivers. This process will continue until all roads are accessible and thus safe enough for traffic. 
This procedure is quite intense, partly due to restrictions on working hours and consecutive working 
days, in the Netherlands arranged in the working safety law (arbeidsomstandighedenwet). It also 
intervenes heavily with primary jobs of most employees. Winter gritting always has priority, meaning 
that other all other activities fall behind. 
  
Next to the gritting teams, a key role is reserved for the road authority. This authority is responsible to 
provide the winter service organisation with adequate routing instructions. The next section describes 
this particular role. 
 
 

2.3 The road authority 
The municipality of Rotterdam embodies the road authority and is thus responsible for maintaining 
the local road network in an adequate way, according to Article 15 of the Dutch Road Law (Wegenwet). 
If this party fails to comply with the responsibility and damages occur, with respect to the road user, 
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the road authority can be hold accountable. The possible liability for accidents due to substances on 
the road, amongst them sand and oil, but also snow, frost and ice has to be assessed finally and is 
based on Article 6:162 of the Dutch Civil Code (Burgelijk Wetboek).  
 
In this liability claim a key point is till which degree the road authority is to blame for the actual 
situation. In principium the burden of proof is on the side of the plaintiff. However, due to the 
predictability of roads- icing the road authority should be able to proof that structural measures have 
been taken place to control complete road management. The municipality of Rotterdam takes the 
following actions to avoid liability claims, including (Municipality of Rotterdam, 2015: pp. 9-10): 
 
➔ To establish a management- and execution plan for gritting, including a detailed presentation 

of routes and corresponding priority. This priority setting is based on hazardous analyses and 
previous complains which have been recorded in a ‘’complaint registration system’’. 

➔ To keep administration of the times when gritting was executed and all actions as of a result 
of notifications of any kind. 

➔ To control the effectiveness of gritting actions and to log all problems. 
➔ To communicate to citizens (and other parties, red) about gritting management and what the 

citizens can expect from the municipality. 
  
To maintain the entire road network the following actions are taken in diverse areas of snow removal. 
These actions will be discussed separately in terms of time management, preventive spreading and 
salt usage. Although the winter service organisation is advising on some of these measures as well, 
they ultimately fall within the responsibility of the road authority.  
 
Time management  
The most important rule which the road authority must follow is that all roads are subject to a time 
window in which the roads have to be gritted. This time window differs for the various types of roads 
(table 2.1). The municipality agreed upon a time schedule of 2 hours which is in line with the national 
standard (Municipality of Rotterdam, 2013). Those timeframes are based on the so called ‘gritting 
times’ and taken from the moment the vehicle leaves the depot till the last square meters of the roads 
are actually sprinkled, and not when the command is being made by the central winter service 
coordinator. 
 
Table 2.1 Time window gritting routes  
 

Motorways Max 1½ hours 

Provincial roads Max 1½ hours 

Municipal main roads Max 2 hours 
(source: Municipality of Rotterdam, 2013: p.7) 

 
The time windows are primarily meant for curative actions. Curative actions do take place when the 
roads are already subject to snow/ice. Preventive actions, on the other hand, are used to sprinkle salt 
on ‘’clear’ roads, based on the prediction that slipperiness will occur in the near future. With preventive 
actions it is possible to have more flexibility. However, in practice the municipality chooses to respect 
the time window for both curative and preventive actions. This is done because Rotterdam is an 
urbanized area (Municipality of Rotterdam, 2013: p.5) and to minimize risk due to vehicle/route 
switching within different scenarios. Experience learns that due to the constant switching scenarios 
(routing is available on paper map only) mistakes can be made easily. Small mistakes in gritting roads 
might lead to traffic jams and more importantly, create possible unsafe situations. 
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The fact that there are time windows for curative actions, does not mean that in every case everything 
is gritted within the two hour time period. In some cases a small violation of the two hour mark may 
save a vast share in the total routing time, or even make it possible to make cuts in the number of 
vehicles needed. Also, vehicles may get stuck in traffic jams. This is primarily the case when the gritting 

is used as a curative measure. Nowadays more and more municipalities try to avoid curative measures 
and actively steer to preventive spreading. 
 

Preventive spreading 
In the nota mobility of the ministry of traffic and water (Verkeer en Waterstaat) an integral vision is 
given for the accessibility, safety and flow of traffic until 2020. Within this vision the prevention of 
slipperiness, where is possible, has preference above curative spreading. The municipality embraces 
this vision (Municipality of Rotterdam, 2013: p.4). Of course, curative measures are taken when this is 
necessary. 
 
Preventive spreading has a few advantages against curative spreading: (i) slippery roads are avoided, 
(ii) spreading can be done at a better time benefiting both the duration time (less traffic) and to make 
sure that the other daily activities of the workers can continue and (iii) less time pressure.  The 
disadvantage is that it can happen that a preventive spreading has taken place which, in hindsight, was 
not needed (Municipality of Rotterdam, 2015: p.11). 
 
Salt usage 
Two different types of salt exist: dry and wet. The municipality is using wet salt already during a few 
years. Wet salt is a combination of a type of salt (in this case rock salt is used) with an additional 80% 
water (Municipality of Rotterdam, 2015: p.11). The advantage is that less salt is needed to achieve the 
same effect and thus cheaper. On top the wet substance binds better to the road surface, resulting 
due which it is less likely cars will redistribute the sprinkles elsewhere onto the road or into the road 
bank. A last advantage can be found in environmental protection; less salt is better for the 
environment, as it will distribute less into road banks and therefore damages less habitat and flora. 
The quantity of salt used per situation may vary (table 2.2). Most common is the use of seven grams 
per square meter to salt. Not only the amount of salt is controlled, but also the width of spreading, 
which is currently done manually by the driver.  
 
Table 2.2 Amount of salt used  
 

Preventive Wet 7 gram/m2 

Preventive Dry 10 gram/m2 

Curative Wet 10 gram/m2 

Curative Dry 15 gram/m2 

Curative Snow 20-30 gram/m2 
 (source: Municipality of Rotterdam, 2013: p.7) 

 
The introduction of wet salt decreased the total amount of salt used. Together with the previous 
discussed time window of two hours after leaving the depot, it nowadays rarely happens that a vehicle 
is running out of salt in service (Gerlagh, 1998).  
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2.4 Determining gritting routes 
The municipality of Rotterdam has a total of 72 different routes throughout the entire city of 
Rotterdam. These routes are created and adjusted by the road authority and winter service 
organization, with the help of cartographers from the in-house GIS advisory team. For online 
publishment see the Rotterdam GISweb portal (http://www.gis.rotterdam.nl/gisweb2/default.aspx). 
The user can select both bike lanes, main motorways routes and corresponding vehicle which is subject 
to spreading.  
 
All routes are subdivided into 2 categories and 3 subcategories. Firstly, a distinction is made between 
motorways (30 routes) and bike lanes (42 routes). Due to the vehicle width, different vehicles routes 
are needed. For motorways, another subdivision can be made between access routes and other main 
motorway routes. When Rijkswaterstaat and/or the official ‘’Province of Southern Holland’’ decide to 
a preventive salt spread action, the central coordinator will be informed. Consultation with the 
meteorologist ends with the decision whether all routes are included, or only a subset, so called ‘access 
routes’. This subjection consists of 8 out of a total of 30 routes which deal with critical infrastructures 
and frosty spots. These are primarily bridges and shadowy places, as those are subject to lower surface 
temperatures and make them more susceptible to frost. 
 
Remaining main motorway routes are selected based on various selection criteria (Municipality of 
Rotterdam, 2015, p.6). Most important categories for selection are other area access roads, which can 
be identified by 2x1 or 2x2 lanes, which are separated from each other. The next category is regular 
routes of busses, which are crucial for both bus drivers and passengers. Park and Ride locations are 
also considered to have a high priority, in order to stimulate the use of public transport within the 
inner city. Along with these, calamity routes for hospitals, ambulance-, police, and fire stations are 
added together with other miscellaneous locations as schools, nursing homes, crematoriums and 
cemeteries. Lastly, motorways leading to business and shopping areas are considered of high 
importance, but only during business/opening hours. 
 
Bike lanes are, likewise to bus routes, crucial in relieving car usage during winter times. Next to that, 
bikers tend to use car lanes instead of bike lanes if they are not taken care of properly. It is therefore 
in both car and bike users interest to give high priority to bike lanes. These are both separated bike 
lanes as bike lanes which are next to roadways. Apart from these routes, an additional category is 
marked as low priority. These are considered when there are long lasting poor weather conditions. 
This category contains neighbourhood access roads (erftoegangswegen), other parking facilities and 
pavements in residential areas. Both bike lanes and roads with low priority are excluded from this 
study. The focus is on main motorways. 
 
Although the municipality has certain roads which are in need to be gritted, not all are scheduled for 
this service by the municipality. These are roads which are not serviced by the local winter service 
organisation. National and provincial roads are excluded in the overview. These constructions are 
threefold: 
 
➔ The Gladheidsbestrijding Mainport Rotterdam, which is gritting the private terrain of the port 

of Rotterdam. This private service is the responsibility of the Rotterdam harbour. 
➔ Trade-off roads with neighbourhood municipalities to increase efficiency.  
➔ Contracting to private companies. These roads often are located within remote areas. This is 

the area of Rozenburg (detached to Gladheidsbestrijding MainPort Rotterdam) and Hoek van 
Holland (contracted to municipality of Westland). 
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At the start of each winter, a test drive is organized with involvement of all drivers active during the 
upcoming season. This test is used to inform the staff about new adjustments, but more importantly, 
to check whether routes are okay to drive. Any (i) access problems for vehicles, i.e. roads work, narrow 
streets, redesigned parking facilities (problem for the vehicles) are noticed, (ii) exchange of roads to 
third parties are tested, as well as (iii) newly build roads are added to the existing routes. Furthermore, 
(iv) strategic and operational changes can be a cause to create new gritting sector designs and gritting 
routes. All these events trigger the need for new and/or updated vehicle routing. Route amendments 
are carried out by cartographers within the GIS advisory team. While this solution is sufficient and 
works properly, management parties are looking for enhanced ICT solutions which enable even more 
refined and optimized routing.  
 

2.5 Outlook: ICT in winter service management 
In the winter service policy plan, 2015-2020, relevant developments within the field are introduced. 
Management of salt usage is important to ultimately reduce the amount. This can be achieved by using 
‘dynamic winter gritting’ techniques, currently not yet used in Rotterdam. It consists of various 
measures to control salt usage, like correct gritting widths and the use of infrared measures to have a 
better salt dose precision (Municipality of Rotterdam, 2013: p.12).  
 
The winter service department started the WINTER project in October 2016 to enhance the use of ICT 
applications within vehicles and the salt spreading machines. As noted in the introduction, four main 
goals were formulated for the use of ICT applications: (i) increase the safety of employees and other 
road users by adopting route guidance, (ii) more sustainable use of salt and less vehicle miles, (iii) 
reducing costs by a decrease of man-hours while upholding high service levels and (iv) aiming for less 
reserve drivers, again to decrease costs. 
 
To obtain these goals the project is partitioned into several phases and deliverables, from the 
digitalization of routes to the logging of the actual salt spread on roadways (table 1.1, page 4). With 
respect to the routing of vehicles, the project should result in the availability of (i) digitised salt 
spreading lanes, (ii) optimized routing, (iii) route guidance for drivers within their cabin and (iv) 
automated salting and actual reporting about routing and salt usage. For this thesis the first two points 
are of interest, digitised salt spreading lanes and optimized routing. These are used as input for the 
remaining deliverables. 
 
Routes can be optimized in two ways. optimize the current routing; drivers depart almost at the same 
time, but arrive at different times, and many of them arrive too early. Another item is the percentage 
of deadheaded kilometres, which should be reduced. But the main problem is more structural and is 
embedded into the design itself. The initial design is based on former municipality districts which are 
now outdated and lost their value. Recently the gritting system diminished, instead of three depots 
only two depots are active, but this transition has not been adapted. Second, routing and its 
combination with different scenarios are suboptimal. At present there are two scenarios: 1. grit only 
access routes or 2. grit everything. The scenarios themselves are acceptable, but routing for the access 
routing scenario is incorporated in the ‘grit everything’ scenario. And if one wants to specify further, a 
distinction can be made between using snow shovels or not. This allows a wider gritting width when 
sprinkling only, including a combination of gritted lanes. The adopted WINTER project encompasses 
both navigation and automatic width control of the salt spreader. This opens possibilities to recreate 
routing not only from a single route optimization perspective, but various routes for drivers while 
upholding high safety standard for drivers.   
 
Theoretically it is possible to design several scenarios, but now only one scenario is used due to the 
fact that drivers only grit a few times a year. Many times, drivers are instantly being called upon for a 
night shift (3/4am) to clear the roads before the morning rush hour. Drivers operate in the middle of 
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the night, only one person per vehicle, with a paper map navigation while driving on possibly slippery 
roads and in the meantime they have to manually adjust the width of their salt spreader. Subsequently, 
it has been calculated that if a turnout goes wrong, damage to society can be up to three times the 
annual budget (O’Keefe & Shi, 2006: p.5). Therefore, to temporarily keep the same routing for both 
scenarios to decrease the creation of human errors and to increase the safety of personnel by sticking 
to only one route per driver, is the first choice. However, one could choose to calculate multiple 
scenarios, after the first practical tests with the routing model seem promising. 
 

2.6 Summary 
This chapter introduced the main concepts of the winter service section, with a focus on its origin and 
creation. At the beginning of the chapter it is argued that the winter road maintenance decision making 
has comparable elements with a ‘Greek temple organization’. Both operational and tactical decisions, 
and even strategic ones, are taken by the winter service organization and road authority departments, 
each holding responsibility for different parts in the logistical chain. The winter service organization 
primarily holds the responsibility for all gritting and related activities. Daily operations for routing, 
transportation management, staff management and inventory control belong to their responsibility. 
They themselves decide when to start gritting and following which scenario. The road authority acts 
as a party which is responsible for safe travel of road users. Several requirements are in place, such as 
a two-hour time restriction for municipal roads and policies on salt usage, but the salt capacity on 
vehicles is not seen as a constraining factor.  
 
The determination of routes is primarily focused on the sector design: which route to grit and why. 
The gritting routes for motorways are divided into two categories: access routes and other main 
motorway routes. Access routes consist of critical infrastructure and frosty spots. For the other main 
motorway routes several criteria are outlined, amongst them main motorway roads, access roads, bus 
lanes, P&R locations, shopping areas and calamity routes for hospitals, ambulance-, police, and fire 
stations. Routes are gritted in only ‘grit access routes’ or’ grit every route’. The weather forecast 
depicts which routing scenario is executed. One should note that routes may change due to the field 
experience of drivers and citizen complaints at the address of the winter service organization. Both 
activities trigger a response from the road authority for route adjustment, not to mention its own 
contribution to changes such as revisited sector design.  
 
While these route adjustments are performed by in-house cartographers, management is exploring 
the possibility of automated and optimized routing solutions. Two possibilities are conceived for 
optimized routing. The first option is the current routing procedures by means of sharper time 
schedules and reducing deadheaded kilometres. There is, however, a more structural embedded call 
on route revising, such as outdated districting and a recent depot abolishment. The second option is 
to develop individual routing for both the ‘grit access routes’ as ‘grit everything’ scenario. This option 
will not yet be investigated in the short term but considered as a future option for vehicle routing.  
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3. Literature review 

 
This chapter reviews the literature regarding spreading problems. After starting an initial exploration 
of the winter service section in chapter 2, the spreading problem is defined in section 3.1. The derived 
spreading operation characteristics are set out in section 3.2. Section 3.3 presents several methods to 
incorporate the spreading problem into a routing model, as well as assessed that the vehicle routing 
model suits the problem best. In section 3.4 possible solution methods for this problem are given. As 
a next step section 3.5 considers the implementation of a vehicle routing model into a GIS 
environment. Section 3.6 syntheses the organisational framework (chapter 2) and the proceedings of 
the literature review (chapter 3) and merged these into a coherent conceptual model.  
 

3.1 The spreading problem 
Different problem sets and models exist and are described in literature on spreading operations. 
Before diving into these models, it is essential to understand those operations more in detail.  Perrier 
et al. (2010) explain the spreading problem as follows:  
 
“The routing of vehicles for spreading operations is the problem of designing a set of routes such that 
all required road segments of a transportation network are serviced by a fleet of spreaders, which may 
be heterogeneous vehicles (e.g., trucks of different capacities) based at multiple depots. The 
transportation network is generally described through a graph, whose arcs and edges represent the 
one-way streets and two-way streets to be serviced, respectively, and whose nodes correspond to the 
road junctions and to vehicle and materials depot locations. Not every road segment may need to be 
serviced and road segments with positive demands (amount of chemicals and abrasives) are called 
required road segments” (Perrier et al., 2010: p.3). 
 
This small introduction contains four main elements which suit the problem as depicted in the previous 
chapter: (i) the possibility to include heterogeneous vehicles, (ii) multiple depot locations, (iii) 
transportation network, but represented as a graph with one-way and two-way streets to be serviced 
and (iv) not every road segment may need service. To fully grasp the spreading problem, a solution 
was made to decipher the problem set into problem characteristics. Little differences in the problem 
characteristics may easily lead to results which cannot be applied to real-life routing solutions.  
 

3.2 Spreading operations characteristics 

Numerous factors do exist in this spreading problem, which depict a part of the problem environment 
constraints and should be considered when embedding the solution (Perrier et al., 2010). Several 
studies have developed taxonomies to deal with both routing problems (see e.g. Bodin & Golden, 1981; 
Anbuudayasankar et al., 2014) and spreading problems (Perrier et al., 2007; Perrier et al., 2010;  Xie et 
al., 2013). This thesis uses the taxonomy of Perrier et al (2007) for the problem set. The reader is 
referred to the study by Assad & Golden (1995), which specifically dive into characteristics different 
for spreading in comparison to other routing problems. For this moment, the main characteristics and 
sub characteristics are addressed and described in more detail. 
 

3.2.1 Transportation network 
Network models are used as an abstract representation of real-world components and therefore the 
basic component of vehicle routing. A network can be defined as “a set of interconnected linear 
features through which materials, goods and people are transported or along which communication 
of information is achieved” (Heywood et al., 2011: p.95). These interconnected linear features 
represent numerous different phenomena, such as transport-, utilities-, or hydrological networks. Our 
focus lies within a transport network design, but in an urban context. The components of a network 
can be divided into arcs (one-way flows), edges (two-way flows) and nodes (figure 3.1). The nodes are 
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used as vertices (to link arcs and edges), to account for the connectivity or may function as ending 
points or junctions. Besides this, turns are included, representing the transition from one arc or edge 
to another. Turns, arcs and edges are all represented as lines, whereas nodes are represented as points 
(dots) in this network data model (Heywood et al., 2011).  The transportation network is also displayed 
as an UML diagram (figure 3.2). This provides a more database overview and the relationship between 
the key aspects of network, manoeuvres and junctions.  
 

 
 
 
The representation of the network in a network data model is determinative for the functionalities 
which one can use. One of the modelling choices is between an undirected, directed or a mixed 
network. The undirected network only uses edges, the directed only arcs and the mixed network a 
combination of both edges and arcs. A mixed network is normally used in dense urban networks to 
represent the transportation network for gritting (Gerlagh, 1998). At first sight this seems an 
appropriate choice, but it may result in increasing computational complexity for modelling vehicle 
routing. This will further be elaborated upon in section 3.3: vehicle routing models for spreading. 
Corresponding to the network data model is also the implication of a maximum time for spreading 
completion (Perrier et al., 2007). For Dutch municipal roads this time is set to two hours after leaving 
the depot for curative spreading; within this time slot all required roads in the network are treated. 
 

3.2.2 Road segments 
The transportation network consists of road segments. These are depicted as an individual asset which 
requires uniform treatment. First one should determine if a road segments needs to be traversed. Not 
all roads are subject to gritting. Road segments which are required to pass at least once are called 
required road segments (Perrier et al., 2007). Associated with required road segments are the costs of 
traversing in terms of length and three different traversal times: the required service time, the 
deadheading time if the road segments are not serviced yet and the deadheading time if the road 
segments are already serviced. (Perrier et al., 2007). Deadheading refers to passing a road segment 
without gritting it.  
 
Consequently, note that not all road segments do have to be passed in exactly one time. Broad roads 
might require more than one passing, whereas multiple small adjacent roads or two-way roads (one 
lane each way) can be serviced in one go (Perrier et al., 2007). In todays practice salt spreading and 
snow ploughing is a single scenario. This means that due to the width and practical troubles of snow 
ploughing several lanes, the use of gritting multiple adjacent roads is ignored. 
 

Figure 3.1 Network data  
model (source: Heywood  
et al., 2011: p. 96). 

Figure 3.2 Transportation network UML class 
diagram. The relationship between network 
from and to directions to junctions and the 
possible relation between junctions and 
(vehicle) manoeuvres. 
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3.2.3 Sectoring 
When winter road operations become too large to manage them effectively, a solution could be to 
separate both personnel and vehicles into smaller subareas. This sectoring or districting “involves the 
partitioning of a large geographical region into sub-areas … according to some criteria, to facilitate the 
organization of the operations to be performed within the region” (Muyldermans et al., 2002: p.521). 
Subareas are referred to as sectors. Sectoring criteria are often guided by a particular problem (Júnior, 
2008), e.g. sectoring is applied successfully for primary school student distribution, voting districts or 
administrative districting; the last one is currently used for road sectoring (Júnior, 2008). While 
administrative districting is applied for managing winter service sectors, other criteria may fit better 
for sectoring design (Perrier et al., 2006). The design should preferably be based on the transportation 
network rather than administrative boundaries. Part of this transport network are network facilities 
such as vehicle depots and salt replenishment stations (Perrier et al., 2006). 
 
Perrier et al. (2006) did set out three standard criteria for designing sectors: compactness, balance in 
workload, and continuity. Compactness depends on both the number of sectors and depots. If the 
number of sectors is equal to the number of the depots, those depots lie in the sector centre. If the 
number of sectors exceeds the depots, they are in general districted by means of an effective way of 
the type of winter road operations (Perrier et al., 2006). This number of sectors in which routing 
towards the sector and back to the depot in the leading design principle. The balance in workload 
trickles down to basic criteria, such as length of streets, travel time or expected snowfall. Perrier et al. 
(2006) note that if using the length of streets as a sector criterium, the computational time may 
become an issue. An option could look like choosing districts based on the continuity or a collection of 
street segments which include only adjacent streets. The strategy of continuity is effectively used when 
the percentage of deadhead within sectors is minimized and as a result the overall deadheading is 
minimized as well. One has to make sure that road continuity is respected with road segments and 
that they can be linked together. Some road segments might require a different treatment. Different 
characteristics such as priority levels, vehicle specifications or jurisdictional limitations may interfere 
with districting based on continuity (Assad & Golden, 1995; Perrier et al., 2006). 
 
Sectoring can also be based on several administrative or transportation related factors. Choosing an 
appropriate sectoring model can therefore be difficult and rely on multiple practices. Anyhow, the end 
result should take into account the sector robustness (Perrier et al., 2006). Despite the fact that this is 
not a criterion for the initial design set up, for daily operations the outcome is necessary. Small changes 
in selecting gritting roads should fit into the initial design. From an organisational point of view, it 
would be unfavourable if the sectoring should be tossed yearly due to small changes in the operations. 
Ultimately sectoring should enable the organisation to deliver better work for both organisation and 
society.  
 

3.2.4 Vehicles and depots  
All vehicles start and end at multiple vehicle depots and the depot they start is where they end. 
Likewise depots have to be linked to the graph by adding a (depot) node. With each depot a number 
of vehicles are assigned, often different types. These vehicles use specific roads according truck width, 
spreading range and salt capacity. The number of vehicles of each type which it can store safely is 
limited. Within each vehicle depot salt is stored as well as additional vehicle equipment, such as 
shovels. Costs to maintain them are structural and high, especially when considering that it will be 
necessary to use them only several times a year for salt spreading, but in the mean time they have to 
be used for vehicle and salt storage all year round (Gerlagh, 1998). Also vehicles themselves are 
considered to be fixed costs, whereas fuel, materials and maintenance are considered variable costs 
(Gerlagh, 1998: Perrier et al., 2007).  
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3.2.5 Routes and drivers 
All required road segments are divided into one or more routes. They were designed according to 
several constraints deriving from previous characteristics of the transportation network, as there are 
road segments, sectors, vehicles and depots. The start of the route is scheduled by the central 
coordinator, who assigns the starting time and sets the completion time. The workload of the drivers 
is scheduled within these two hours; itis also balanced, i.e. these workloads are approximately of equal 
length and duration (Perrier et al., 2007). Length is calculated in lane-kilometres, since roads may 
require multiple passes or being split into several lanes (Perrier et al., 2007).  
 
As next item considering routing, and in particular salt spreading and ploughing, is the designing of 
routes with only a few special manoeuvres (Perrier et al., 2007). Manoeuvres like U-turns and turns 
which cross traffic lanes are undesired, due to the impact on both completion speed and hindering 
interrupting traffic flows. A well-designed route preferably should not contain too many special 
manoeuvres, long stretches of continuous serviced road segments. To accommodate for both special 
manoeuvres-, sectoring- and time violations the routing model can be incorporated in two different 
manners. First is to simply forbid certain moves, such as U-turns, or ban vehicles from districts. At 
second the action can be penalized. Additional costs can be added to the cost function for violation, 
which makes options only interesting when the savings are significantly higher. Time penalties mean 
that drivers have less time for completion, which brings additional costs and results in the use of 
additional (scheduled) drivers.  
 

3.2.6 Objectives 
Considering all aforementioned characteristics, one has to choose one or several objectives which they 
then strive to optimise. Typical objectives deal with minimising the (i) deadheading or total service 
time, (ii) number of vehicles used or (iii) a given penalty constraint such as left turns, U-turns and/or 
time violations. Associated with these objectives are monetary objectives as minimising (iv) global 
operation costs, (v) fixed costs and (vi) variable costs.   
 
Minimizing objectives is a difficult task, as it contains a conflictive element (Perrier et al., 2006). For 
example, minimization of deadheading can result in an uneven work balance between team members. 
Or crossing too many small roads can lead to discontent amongst drivers. The main question here is: 
“Is it all about minimising the total deadheading or is there a small window for creating an even work 
balance and pleasurable routes to drive?” Trade-offs are hard to make and requires professional 
judgement instead of single minded optimisation (Keenan, 2001). Even more important for assessing 
good routes, is that optimal solutions are not found within the use of algorithms for most practical 
routing problems (Keenan, 2001). This notion, reaching a sub-optimal status quo within routing models 
will be explained in the next section using several routing problems. 
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3.3 Vehicle routing problems for spreading 

Different routing problems are formulated for spreading operations. A vehicle routing problem can be 
defined as “the problem of designing optimal delivery or collection routes from one or several depots 
to a number of geographically scattered cities or customers, subject to side constraints” (Laporte, 
1992: p.345). Different side constraints can be imposed, such as salt capacity and time windows.  
Vehicle routing problems can be divided into two categories: node routing and arc routing. In node 
routing problems the demand is on nodes (or vertices) on the graph (Han, 2015: p.350) Examples of a 
node routing problem are waste collection, internet-based grocery delivery or the distribution from 
warehouses to retailers (Eksioglu et al., 2009). In arc routing problems focus is on the route itself. The 
entire road segment, including the edge, is required to pass (Han, 2015: p.350). Practical examples are 
found in salt spreading, snowploughing and street sweeping, street inspection for maintenance, postal 
delivery and meter reading (Assad & Golden, 1995: p.375). All these examples emphasize the need to 
service these streets entirely. For postal delivery and meter reading density of potential customers can 
be high, whereas at that very moment a street segment is considered to be serviced. Therefore, a 
distinction between node and arc routing is merely a matter of representation of modelling (Assad & 
Golden, 1995: p.375). 
 
Optimisation algorithms are used to solve both arc and node routing problems, whereby the vehicle 
routing problem relies on the mathematical discipline of combinatorial optimization problems (Garey 
& Johnson, 1979). These problems need a countably infinite set of solutions; this, in its turn, has to be 
minimized or maximizes on a given cost function (Michiels et al, 2007). Cost functions generally refer 
to an objective function, but for routing it is in most cases meant to minimize factors like driving time, 
fuel and operational costs (Perrier et al., 2006). 
 
Within optimisation algorithms, an important distinction is made for computational complexity, 
defined as ‘soft and hard’ problems (Michiels, 2007; Keenan, 2001). Soft problems are solved within 
polynomial (P) time: a maximum amount of time required for the algorithm to solve the problem. The 
notation used for algorithms is the capital O (Garey & Johnson, 1979). The O stands for ‘order of 
growth’ and is interested in the running time when the problem size increases. To create a more 
efficient algorithm the order of growth is limited, either by decreasing the problem size or its functional 
complexity. Hard problems, on the other hand, use exponential time algorithms instead of polynomial 
time algorithms to find the optimal solution. Where algorithms with the function O(n) are solved in 
polynomial time, functions of 𝑂(𝑐𝑛) and c is larger than one, increase exponentially when the problem 
size n increases. An example of exponential parameters in a function is the number of nodes (n) or arcs 
in a network (Keenan, 2001). If n becomes too large computer running times can easily run into the 
aeons (table 3.1, next page).  
 
For some of NP-hard problems can be solved in non-deterministic polynomial time. This category of 
problems is known as NP-complete (Michiels, 2007). Little is currently unknown for this class if an 
algorithm exists which is able to solve these problems within polynomial (P) time. If yes, it can be 
validated in polynomial time, answers can be optimisation of algorithms are used checked immediately 
but there’s currently no way to quickly find them as well.  
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Table 3.1 Comparison of polynomial and exponential time complexity functions. In vehicle routing problems the function is 

exponential. An increase in arcs or nodes to the vehicle routing problem has a significant impact on computation time (source: 

Garey & Johnson, 1979: p.7). 

Time 
complexity 

function 
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second 
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second 
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𝑛5 

 
.1 
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13.0 
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Exponential 
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1.0 

second 

 
17.9 

minutes 

 
12.7 
days 

 
35.7 
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366 
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3𝑛 

 
.059 

second 

 
58 

minutes 

 
6.5 
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3855 

centuries 

 
2x108 

centuries 

 
1.3x1013 
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3.4.1 Arc routing problems 
Last decades, definitions and solutions of several arc and node routing problems have been proposed. 
Some of the most prominent ones were introduced by Golden & Wong (1995). The arc routing 
problems are presented in terms of time complexity and how these routing problems are used in 
relation to salt spreading.  
   
Undirected-, directed and mixed postman problem 
One of the theoretical fundaments of arc routing is postulated by Leonhard Euler, mathematician. 
(Keenan, 2001). Euler visited the Prussian city of Köningsberg (nowadays called Kaliningrad, located 
within the Russian Federation) and formulated the ‘Köningsberg bridge problem’ (Eiselt et al., 1995). 
The question was if it is possible to traverse the seven bridges of the Pregel river within the city of 
Köningsberg exactly once and to return to the starting point (Keenan, 2001). Euler showed that this is 
only possible in a closed circuit if nodes consist of an even number of arcs, or if exactly two nodes have 
an odd number of arcs (Keenan, 2001). This closed circuit is known as ‘Euler circuit’ (Hertz, 2005). 
 
Years later the postman problem, or so called the Chinese postman problem, was suggested by the 
Chinese mathematician Kwan Mai-Ko in 1962 (Eisselt et al., 1995). This problem states: a postman has 
to cover his assigned segments before returning to the post office but has to find the shortest walking 
distance (Keenan, 2001: p.101). Likewise to the formulation of Euler, the problem can be solved by 
means of a closed circuit. If not, edges must be covered more than once. These non-required traversals 
are unwanted deadheading arcs (Assad & Golden, 1995). When the graph is completely undirected or 
directed, the postman problem can be solved in polynomial time (Edmonds & Johnson, 1973). But 
when this problem exists of a mix of undirected and directed arcs, it becomes NP-complete (Assad & 
Golden, 1995).  
 
In salt spreading operations Kramberger (2012) uses two formulations of the postman problem. In the 
first he uses the ‘undirected postman problem’. In the second formulation priority nodes are added. 
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This is a possibility, but only if certain roads or areas have been given an increased interest to be 
serviced. This interest is expressed in terms of weight on edges onto the graph. If this weight is minimal, 
the change is likely that solution offered by the undirected postman problem in the first formulation 
will prevail (Kramberger, 2012: p.62). If the weight is considered different, tours may be constructed 
which is largely dependent on the amount of deadheaded edges being used. To divide vehicle and 
depots to certain districts makes the problem itself already NP-complete (Kramberger, 2012: pp.62-
63), although the undirected postman problem can be solved in polynomial time. In practical 
situations, however, multiple vehicles and multiple depots are used.  
 
Rural postman problem / Directed rural postman problem 
The rural postman problem (RPP) attempts to find a single route of minimal length of a selection of 
edges in the network, whereby some edges in the network are visited and some edges are not but may 
be used in the solution. This problem is a variant of the Chinese postman problem (Gerlagh, 1998). The 
RPP is NP-complete, except when the required edges to serve are all passed once. In that case, the 
rural postman problem is reduced to the postman problem, which can be solved in polynomial time 
(Groves & Vuuren, 2005). 
 
Additional deadline classes are used by Letchford and Eglese (1998) in order to solve the rural postman 
problem in salt spreading. Such classes can be useful, for reasons to prioritise roadways based on 
importance to the road network (Campbell, 2000). Recently Quirion-Blais et al (2016) made use of the 
rural postman problem in snow ploughing, instead of gritting, for solving it on a mixed graph with 
arc/edge hierarchy for a given k-number of vehicles. They further consider turn restrictions, route 
balancing and variable vehicle speeds on a real large-scale network (Quirion-Blais et al., 2016: p.1).  
 

Stacker crane problem 
The stacker crane problem is the mixed version of the rural postman problem. A set of directed arcs 
and a set of edges or undirected arcs have to be serviced (Assad & Golden, 1995). The name is derived 
from a stacker crane which must load containers onto a ship. A crane can only lift one container at a 
time and has to construct a route through a series of containers (demand) which should be minimized. 
The stacker crane problem is NP-complete (Frederickson, Hecht & Kim, 1978).  To the best of the 
author’s knowledge no studies exist in which the stacker crane problem is used to model gritting 
routes. 
 

Windy postman problem 
This problem is consistent with the postman problem, however the costs of traversing an arc are 
dependent on the direction in which it crosses (with or against the wind) (Assad & Golden, 1995). This 
cost function of the windy postman problem is therefore not symmetric (Dussault et al., 2013).  
 
Dussault et al. (2013) used the windy postman problem to model snow ploughing operations. They 
proposed a scenario in where on some steep streets it is more difficult, or even impossible, to plough 
uphill. A notion is incorporated that deadheading costs over streets that have already been ploughed 
are significantly less than crossing deadheaded roads which have not been ploughed yet (Dussault et 
al, 2013: p.1047). They have developed a solution which can deal almost optimally with instances up 
to 200 nodes (Dussault et al., 2013). 
 

Capacitated arc routing problem 
The capacitated arc routing problem (CARP) starts from the central depot, in which it should obtain a 
collection of routes of minimum total length, in which the routes themselves have an individual 
demand. The most important restriction is the capacity of the vehicles (Gerlagh, 1998). The CARP is a 
special case of the Rural Postman Problem (RPP) and it is shown to be NP-complete (Assad & Golden, 
1995; Gerlagh, 1998). This implies that only a subset of the required arcs must be served (Gerlagh, 
1998). The CARP can be studied on mixed graphs (Gaspar & Benze, 2016). 
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3.4.2 Node routing problems 
All arc routing problems mentioned can be deduced to node routing problems. Both postman and 
stacker crane problems are enriched examples of the node routing problem of the travelling salesman 
problem (Assad & Golden, 1995). For the travelling salesperson a salesperson has to travel to each city 
within a territory, stopping only once at each location before returning to the location of origin (Curtin 
et al., 2014). The TSP is not of that much importance but could be used to set an initial solution (as 
done by e.g. Hajibabai, 2014). More interesting is the vehicle routing problem (VPR), especially when 
constraints are added such as time windows. 
 

Vehicle Routing Problem  
The VRP can be defined as to define optimal routing for a number of orders to deliver to a set of 
customers which have to be retrieved from a central depot. Due to constraints such as load, distance 
and/or time, one vehicle is unable to deliver these goods from a single depot. The problem is then to 
determine the vehicles needed to serve all customers (Benjamin, 2011: p.8). This involves the number 
of vehicles, minimizing distance and/or distance travelled by the fleet of vehicles. Several variations of 
the VRP exist. This included adding time windows (VRP-TW) or a VRP with limited vehicle capacity 
(CVRP). There are many variations which are developed for the vehicle routing problem (Toth & Vigo, 
2002). These constraints and features that are subject for adding make up the specifics of the vehicle 
routing problem, if desired to be used. These constraints that make up the model choice will now be 
discussed for our specific routing problem. 
 

3.3.3 Model choice: vehicle routing problem 
All problems set have both strengths and weaknesses. The practical situation, however, is the most 
important item to choose the best fitting model. In chapter 2: organisational framework, three points 
were considered of importance for this choice of a suitable routing model: (i) mixed graph, (ii) 
limitation of U-turns and (iii) introduction of a time-window. The actual action needs (iv) multiple 
heterogonous vehicles and (v) multiple depots, whereby (vi) not every street needs servicing. 
 
A polynomial algorithm cannot be used for the problem solving if using a mixed graph. At least this 
problem is considered NP-complete, and therefore optimal solutions cannot be guaranteed. 
Remaining considerations seem to formulate that our routing problem is either the rural postman 
problem on a mixed graph with deadline classes or a vehicle routing problem with time windows. 
Preference goes to model the problem as a VRP-TW, because the algorithms for node routing are more 
advanced (Assad & Golden, 1995; Gerlagh, 1998) and the number of tools and software applications 
are more integrated within node routing problems (Tagmouti et al., 2011; Corberán & Prins, 2010).  
 
Now that the routing problem is defined, the methods in which the problem can be solved are 
considered. 
 

3.4 Solution approaches for VRP 

The solution approaches for the VRP are usually broken down into two types: exact methods and 
heuristics/metaheuristic (Curtin et al., 2014). Exact methods “obtain optimal solutions and guarantee 
their optimality” (Talbi, 2009: p.18). Examples of exact methods are pure optimization problems, such 
as mathematical programming, or classical algorithms such as dynamic programming (which breaks it 
down into more simple sub problems) and branch-and-bound or branch-and-cut algorithms (Caceres-
Cruz et al., 2014; Tabli, 2009). They are used to solve small size routing problems (around 75-100 
visiting nodes) with simple constraints (Caceres-Cruz et al., 2014) 
 
Heuristics and metaheuristics provide near-optimal solutions for medium and large-sized problems 
with optional more complex constraints (Caceres-Cruz et al., 2014). Using (meta)heuristic can be 
beneficial for three reasons: faster problem solving, solving larger problems, and obtaining more 
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robust algorithms (Caceres-Cruz et al., 2014: p.7). In general, these heuristics are designed to solve a 
specific problem or instance, whereby metaheuristics are used as a framework for almost all 
optimisation problems (Talbi, 2009). Discussing all (meta)heuristics for the vehicle routing will go 
beyond the scope of this thesis. For overview studies the reader is referred to reviews studies of e.g. 
Anbuudayasankar et al. (2014) and Cordeau et al. (2002). Here the focus is on three types of operations 
with appropriate heuristics: the configuration of an initial solution with a constructive heuristic 
(nearest neighbour), improvement procedure by means of local search (2-opt, 3-opt) and the short 
memory-based metaheuristic of tabu search.   
 
Before optimising it is necessary to start with an initial solution. One way of achieving this is using the 
nearest neighbour algorithm. It starts with any node at the beginning (e.g. depot) and adds the closest 
node to the route. This continues until all the nodes are allocated. It is one of the first examples to 
construct a tour for the travelling salesman problem (Caceres-Cruz et al., 2014). Although it creates a 
quick solution, it does generally not lead to optimal results. The solution may be feasible, but it does 
not have to. In routing the initial solution may violate constraints such as time restrictions (Caceres-
Cruz et al., 2014).  
 
Improvement procedures take an initial solution and try to improve it. This 
can be achieved using the locally available search space, that is, moving nodes 
between routes. Doing this for two nodes in the same route is called 2-opt 
(figure 3.3). More of these local improvements are used. Examples are 3-opt 
moves whereby one node is replaced by two other nodes in the tour and a 
shift move, whereby one node is removed from a route and replaced in 
another route. If the move is only used when the newly generate route is an 
improvement on the current variant it is called an iterative improvement 
(Han, 2016). The problem with these improvement procedures is that they 
are trapped in a so called local optimum. A local optimum is achieved when 
in the current solution no iterative improvements can be made within the 
local search space. Global optima is the optimum of the entire function (Luke, 
2015: p.14). If an algorithm gets stuck in a local optimum, the only way out is 
to accept deteriorations of the objective function under certain conditions. 
These strategies can all be achieved with the use of metaheuristics. 
 
Metaheuristics are used as a framework for almost all optimisation problems (Talbi, 2009). Luke (2015) 
describes the use of metaheuristics: “Metaheuristics are applied to I know it when I see it problems. 
They’re algorithms used to find answers to problems when you have very little to help you: you don’t 
know beforehand what the optimal solution looks like, you don’t know how to go about finding it in a 
principled way, you have very little heuristic information to go on, and brute-force search is out of the 
question because the space is too large. But if you’re given a candidate solution to your problem, you 
can test it and assess how good it is. That is, you know a good one when you see it” (Luke, 2015: p.9). 
The vehicle routing problem fits perfectly within this description. Many metaheuristics exist (i.e. 
simulated annealing, genetic algorithms, ant colony optimisation). This study particularly focuses on 
the metaheuristic of tabu search.  
 
Tabu search is considered a suitable approach to solve large vehicle routing problems (Curtin et al., 
2014). These are also used in a special way by vehicle routing problem with additional constraints, such 
as time windows and capacity problems. Tabu search keeps a history of recently considered candidate 
solutions which is called a tabu list. If candidate solutions for the next iteration is on the tabu list, they 
are refused until they’re sufficiently far in the past (Luke, 2015). This means if candidate solutions 
perform worse than current solutions, these are still accepted and the algorithm is not permitted to 
hold on the current solution. How long moves do remain in the tabu list is dependent on the iteration 
settings (Krichen et al., 2014).  

Figure 3.3 2-opt move 
whereby orders the frequency 
b-e and e-f is opted to b-c and 
e-f. 
 

https://www.google.nl/url?sa=i&rct=j&q=&esrc=s&source=images&cd=&cad=rja&uact=8&ved=0ahUKEwi3tYXW_dfSAhXQhRoKHXCBCs8QjRwIBw&url=https://commons.wikimedia.org/wiki/File:2-opt_wiki.png&psig=AFQjCNGoXyOq-4z_wup3xm3MXLaZ7_UmYg&ust=1489649140132749
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Next to the tabu list, the best overall score is kept and stored. Several criteria can override the tabu 
list, called aspiration criteria (Luke, 2015). The most common one is the allowance of a move if results 
are better objective value (Curtin et al., 2014). Because of its overall good performance, well 
documented literature and easy implementation for users, tabu search based algorithms are widely 
employed in GIS (Curtin et al., 2014; Cordeau et al., 2002).   
 

3.5 Implementation of vehicle routing models in geographic information systems 

Geographic information systems (GIS) are of utmost importance in transportation network modelling 
(Kuby et al., 2005; Fischer, 2004). A GIS can be defined as “computer-based systems for the capture, 
storage, manipulation, display, and analysis of geographic information” (Thrill, 2000: p.4). The ability 
of GIS to integrate these multiple functionalities into one working structure is key to bring different 
technologies onto one platform (Thill, 2000). Loidt et al. (2015) reported three analytical components 
of transportation GIS: modelling, analysis and simulation (2015: p.2). These analytical components 
generate new information with consideration of the spatial nature of transportation. In regard to 
vehicle routing, the modelling aspects within the analytical components are important, but analysis 
and simulation of transportation related data within salt spreading can also benefit from GIS. 
 
Implementing vehicle routing models into a GIS may generate several benefits in comparison to other 
approaches, like transport modelling software product or mathematical optimisation studios. Assad & 
Golden (1995) note that GIS can handle network data sufficiently, whereby other attempts try to 
bypass the obstacles of obtaining and using detailed geographic data (Assad & Golden, 1995). 
Euclidean distances instead of network distances are used, and travel times were estimated using 
regressions to fit the actual travel distances based on i.e. linear or Euclidean norms (Assad & Golden, 
1995; Levinson & El-Geneidy, 2007; Keenan, 2008). This is especially relevant for intra-city and urban 
street networks (Assad & Golden, 1995). Subsequently, information about which side of the street 
network is used and the driver actions of turn restriction and penalties greatly help the translation 
from a modelling representation into the actual use of real street networks. This creates feasible paths 
which can be used in real routing and increase the acceptability of final routing (Assad & Golden, 1995: 
p.382-383). 
 
Besides handling network data, additional data sources can easily be stored by means of a GIS 
environment. These data can be conveniently manipulated by the same system when adjustments are 
required (Assad & Golden, 1995). And different data sources can be linked to this routing information 
to provide greater insights such as demographics or weather data (Assad & Golden, 1995). These 
overlays with both transportation and non-transportation data can improve insights in transportation 
policy and land-use interaction (Kuby et al., 2005: p.15).  
 
A special role for combining transportation and non-transportation data does exist for zoning or route 
districting. If multiple vehicles are able to service an area, GIS can be used very effectively to restrict 
vehicles to certain areas, based on depot location or other reasons. Dividing an area of interest into 
districts can be based on pre-set boundaries, such as neighbourhood, census blocks or different traffic 
analysed zones (Kuby et al., 2005: p.15). A GIS enables users to quickly change zoning systems and 
rerunning the analysis, whereas complexity of zoning can be better understood (Kuby et al., 2005). 
Partitioning different transportation zones cannot be executed in a ‘correct way’ but understanding 
how zoning has an impact on transportation decisions is a main feature of a GIS (Kuby et al., 2005). 
 
Next, the interaction from the user with the routing algorithms is a strong feature within the GIS 
environment (Assad & Golden, 1995). This is particularly possible due to mapping and display features 
of a GIS, which serves as a feedback loop to data integration and tweaking of parameters within routing 
models (Loidt et al., 2015). Keenan (2001: 2008) mentions spatial decision support systems (SDSS) 
rather than GIS. Here a GIS is used for decision-makers to redefine the problem and generate 
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alternative solutions rather than focussing on one answer (Kuby et al., 2005). Keenan (2001) notes “... 
the value of [a] SDSS is not determined by its innovative use of technology. Rather the contribution of 
these applications will be determined how well they support the need for a spatial component in 
decision-making” (Keenan, 2001: p.52). 
 
While on the one hand this is true for decision making, the innovative use of technology is the weak 
spot of many GIS-T applications on the other hand. Many software programs may be used to analyse 
location problems, but they end up working as a ‘black box’ (Mapa & Lima, 2014: p.845) and do not 
clearly state which solution methods they use in transportation modelling (Mapa & Lima, 2014: p.845; 
Curtin et al., 2014). Some do not even admit using heuristics and occasionally state that optimal routing 
is provided using their software (Curtin et al., 2014: p.292). Therefore users need to be aware of the 
algorithmic performance of the various routing software available.  
 
One way of unravelling the output performance of these black boxes is thoroughly testing the accuracy 
of the heuristic implemented. Accuracy measures the degree of suboptimality of a heuristic solution 
from the original value (Cordeau et al, 2002: p.513). One way of doing this is by comparing heuristic 
implementation with exact solutions. While this procedure is not done yet with vehicle routing 
algorithms, comparative studies about algorithms of travelling salesman problems and location 
problem analyses in comparison to exact heuristics show that GIS-T applications perform suboptimally 
(Curtin et al., 2014; Mapa & Lima, 2014). Mapa & Lima (2014) look at facility location and 
transportation problem and compare the heuristics of TransCAD with exact mathematical models 
based on Mixed Integer Linear Programming, finding suboptimal solutions up to 37%. Curtin et al 
(2014) show that for several GIS packages (ArcView 3.2, ArcGIS 9.1, ArcLogsitics Route and Integraph 
Geomedia) that the TSP solvers perform suboptimal (on average ~15% above optimality) on problems 
ranging from 10-20 stops (Curtin et al., 2014: p.297).  However, the percentage of suboptimality 
decreases with an increase of the number of stops. Instances of larger than 25 stops are not compared 
to exact heuristics, because it takes a too long computational time. This is unfortunate, because it 
provides a limited sample on optimization problem on large-scale networks. 
 
The only study which describes the algorithmic side on vehicle routing problems and GIS is by Kim & 
Bea (2016). They looked at a vehicle routing problem for delivering packages of a big online retailer in 
South-Korea. They collected 337 delivery vehicle operations in the month of February. They compared 
these data to compare two metaheuristic algorithms on their performance: a tabu search algorithm of 
ArcGIS 10.1 with a genetic algorithm built in MATLAB. In almost every instance the tabu search 
algorithm performed better: an average of 12.8% decrease in driving minutes. As this result is 
compared with one metaheuristic, performed on a small instance (6 vehicles, each with a few 
deliveries) and without the use of time windows, no conclusions can be drawn. 
 
In summary, GIS-(T) has many advantages to offer when developing an integral routing model. It can 
well handle network data, as well as manipulating network data input and interacting with routing 
algorithms. This interaction is mostly limited to setting input parameters of different routing scenarios. 
The algorithm itself remains a black box, and often leads to misinterpretation of solutions. Only a few 
studies have actually compared these GIS black boxes to ILP/MILP models and show suboptimal 
results. Kim & Bea (2016) have compared metaheuristics within a GIS environment and shown 
sufficient results, but large comparison studies remain scarce till today. 
 

3.6 Conceptual model 
Based on the exploration of both the organisational and theoretical perspective on salt spreading a 
conceptual model is established (figure 3.4). Both organisational decision-making and routing 
characteristics are brought together in this model and are interlinked with relationships either on 
directional or bi-directional level. At the bottom characteristics that collectively influence the staff 
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routing are visualised. The concept as presented here is a modified version based on the work of 
Gutiérrez & Vidal (2013) on health care logistics and was redesigned for salt spreading problems.  

 
Figure 3.4 Conceptual model. Representing characteristics and underlying relations resulting in staff routing (in green) 
 
The X and Y axis represent the decision-making structure of the organisation. The winter service section 
divided into the winter service organisation and road authority; the first manages the transportation 
and staff management and second the network design. Planning horizons determine that both 
departments are responsible for operational, tactical and sometimes strategic decisions. The strategy 
definition is however taken in a higher management level and directs and steers individual 
characteristics on their behalf. The WINTER project is of a certain strategic importance, whereby the 
strategic used ICT technologies trickle down via strategic and tactical decisions to the core of the 
operational model and staff routing. The X and Y axis of the model, together with the strategy 
definition is depicted as Greek temple organisation structure. Communication between the 
departments and the project team is vital for adequately designing and implementing routing. 
 
The boxes represent the spreading operation characteristics, placed within decision making structures, 
which details the management decision and planning horizon. Note the reciprocal relation between 
the strategy definition, (required) road segments, sector design and depot location. A change in one 
of these four characteristics leads to a tactical and strategic revaluation of the design of the entire 
network. The outcome of this process has severe impacts on all other elements in the logistical chain 
up to the staff routing. In the left-down corner of the model two grey boxes of traffic condition and 
road work are crossed out. These characteristics are excluded from research but should not be 
forgotten during the actual planning process of daily routing.  
 
Many routing models exists to generate staff routing which are highlighted in green. Exploration of 
different vehicle routing models and their application to salt spreading, combined with the practical 
and operational issues, led to the choice of a vehicle routing model. For this purpose, arcs and edges 
will be transformed into nodes. Staff routing will be solved using the metaheuristic procedure of tabu 
search, which will be incorporated into a geographical information system.    
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4. Methodology 
 
This chapter provides both methodological aspects and a description of the routing model. The first 
part explains the research method of choice (section 4.1), study area (section 4.2) and software 
(section 4.3). The entire model is introduced in section 4.5 which is documented in section 4.6 and 4.7. 
Concluding remarks finish the chapter (section 4.8). 
 

4.1 Research method 
The research structure of problem solving is based on the system view of Mitroff et al. (1974). It 
ensures to follow a proper structure with corresponding research steps of this thesis. The systemic 
perspective is created to study science from a holistic approach. Disregarding a whole system 
perspective and a holistic view may lead to a miss of essential characteristics of this set of problems 
(Mitroff et al., 1974: p.46). The structure consists of four phases: conceptualisation, modelling, model 
solving and implementation (figure 4.1). 
 
The conceptualisation (1) retrieves both the routing model factors found in practices as well as the 
literature brought together in a conceptual model. Here, the routing model was built in the modelling 
phase (2) and defines the relationships and modelling steps, as well as GIS architecture. This will lead 
to prepare input data and the creation of the routing model itself. The model solving phase (3) 
proposed different routing scenarios which will be solved using this model. The implementation phase 
(4), unfortunately, is hard to quantify since the routing project is still in the exploration phase. To fill in 
the void and get an understanding on how the implementation can be beneficial within the 
organisation, the model and solutions are being reviewed. Phase four consists of discussing 
implementation possibilities of the model within the organisation. As described in the introduction, 
research questions (RQs) are based on both structure and sequence of the system view problem 
solving. 
 
 

 
 

1. Conceptualisation 

 

Factors retrieved from current practices 

 

RQ1 
 

Retrieve factors from literature  

 

RQ2 
 

Create conceptual model 

 

 

2. Modelling 

 

Data input 

 

RQ3 
 

Create routing workflow 

 

 

3. Model solving 

 

Scenario analyses 

 

RQ4 
 

Scenario overview 

 

 

4. Implementation 

 

Routing workflow discussion 

 

RQ5 
 

Possible implementation within organisation 
 

Figure 4.1 A four-step framework of the systems view of problem-solving. Each of the four-steps is linked to a specific 
research question which are formulated in the thesis’s introduction.  
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4.2 Study area: Hoogvliet 
The municipality of Rotterdam counted a total of 629 606 inhabitants on January first, 2016, which 
makes it the second largest city in the Netherlands (Municipality of Rotterdam, 2018). Currently the 
municipality services by means of gritting routes 990 km of roads and 630 km of bike lanes 
(Municipality of Rotterdam, 2014). This is carried out from two central depots (figure 4.2). For this 
gritting operation, they use 22 big gritting vehicles and 42 medium gritting vehicles (Municipality of 
Rotterdam, 2014). This study focuses on a part of Rotterdam and our routing model is initially 
developed and tested for this part only. This allows the author to develop a GIS prototype and to 
provide a concept. In a later phase, this concept can be expanded to remaining roads in the city of 
Rotterdam and completes the entire gritting service system.  
 
The area of Hoogvliet is chosen in order to set up an initial model (figure 4.2). Rotterdam annexed 
Hoogvliet in 1934, as well as the city of Pernis. The area consists mainly of residential areas built during 
the 1960’s of the last century (HGH, 2018). Hoogvliet is located in the southern part of Rotterdam and 
comprises of two main gritting routes: HR_044 and HR_045 (appendix A). Gritting route HR_045 is 
approximately 43 km in length1 and is routing in the neighbourhoods of Zalmplaat, Boomgaardshoek, 
Meeuwenplaat, Middengebied, Centrum, Westpunt and Nieuw-Engeland. Gritting route HR_044 is 
around 27 km in length and routed in the neighbourhoods of Oudeland and Tussenwater. Also, the 
access route to the small residential area of Pernis (North-East of Hoogvliet) is serviced by the current 
routing. The number of deadheaded kilometres is estimated to be around 8% for route HR_044 and 
28% for HR_0442 respectively. 
 
To develop a GIS routing prototype, the Hoogvliet is suitable as a study area for several reasons. The 
area (i) is relatively small, but compact for routing, is largely surrounded by the river Oude Maas on 
the south and west, motorway A15 in the North and agricultural fields in the east. Also, Hoogvliet (ii) 
consists actually of more than one route, which allows us to use districting to group routes. These 
routes (iii) have a high amount of deadheading, probably resulting in promising solutions. Also (iv) the 
workload of the routes (27 km against 43km in length) is unbalanced and on top (v) the depot is not 
located within the area itself. This forces to include several starting points, both from highways and 
local roads. It also is (vi) not too large to solve for routing algorithms. At last, (vi) the winter service 
organisation uses also Hoogvliet when experimenting in new techniques, such as applying different 
kinds of salt. 

 

                                                           
1 This estimation is based on initial assumption of the current digitised gritting routes and does not incorporate the travel 
kilometres from thSce depot to the start location and from the end point back to the depot.  
2 The estimation of deadhead kilometres is within the servicing time ( i.e. between the first and last road serviced), travel 
kilometres from and to the depot are excluded. Taken the last remark into account the percentage of deadheading is even 
larger than the current estimation. 

Figure 4.2 The municipality of Rotterdam located in the Netherlands (left), the location 
of the of Giessenweg & Laagjes depot (middle) and the gritting routes of Hoogvliet 
(right). 
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4.3 Software 

The choice of GIS routing software is the most important choice to make for routing model creation. 
Different GIS software packages are available, with pros and cons for route modelling. Three points 
have been summarised within the organisational framework al considered important for choosing the 
most suitable routing model. These are, again, (i) mixed graph, (ii) limitation of U-turns or other special 
manoeuvres and (iii) introduction of a time-window. The situation takes place with (iv) multiple 
heterogonous vehicles, (v) multiple depots and (vi) not every street needs servicing. Next to these 
routing issues, attention has been given to organisational applicability in terms of software, data and 
knowledge of GIS systems. This to ensure that the developed routing model can be implemented 
sustainably within the municipality of Rotterdam. Several alternatives, including QGIS, TransCAD, Open 
Source Projects and ArcGIS. will be discussed. 
 
QGIS is an open source GIS program to support geospatial information editing and analyses. The most 
known routing application which relied on QGIS is PG Routing. PG routing is an open source project 
which extends the PostGIS / PostgreSQL geospatial database to create geospatial routing and 
functionalities. Data and attributes can be easily changed using GIS clients like QGIS but also uDig (PG 
Routing, 2018). The project contains several routing algorithms, e.g. the Floyd-Warshall Algorithm for 
all pairs shortest path, Travelling Sales Person and Turn Restriction Shortest Path (TRSP). The project 
does not include solutions for vehicle problems or arc routing problems. On the website of QGIS a 
plugin of the Chinese postman plugin is available3, but this does not account for the wish to use only a 
certain amount of the network (rural postman problem) and time-window implementation. Therefore 
no current available plugins for QGIS are preferred to accomplish our route optimization.  
 
TransCAD is a state-of-the-art GIS program and designed to help transportation professionals store, 
display, manage, and analyse transportation data. It offers several routing functionalities, amongst 
which the vehicle routing problem and even solutions for arc routing problems. It does seem to include 
many of the preferred options, such as time windows, multiple depots and even the possibilities to use 
non-homogenous vehicle fleets (TransCAD, 2018). The downside of TransCAD is that the municipality 
of Rotterdam doesn’t own a license yet. Licenses are quite expensive, being $12.000/year for a single 
licence (TransCAD, 2018). Also, the knowledge of these software packages within the municipality of 
Rotterdam is limited. And on top, it is unknown if the used TomTom Multinet dataset can be correctly 
loaded into TransCAD. Ranging these potential organisational and financial drawbacks, this option is 
therefore not preferred. 
 
For arc and vehicle routing some open source projects are available. Mourão & Pinto (2017) made an 
overview of open source software for solving various arc routing problems and instances. Most notable 
of this list is the work of Oliver Lum (2017) on creating an Open-source Arc Routing Library (OAR Lib). 
In this library several heuristics have been deployed for instances on the Chinese postman problem, 
directed rural postman problem and the windy rural postman problem. It works with Open StreetMap 
data and visualization utilities have been built-in. All these formulations of the arc routing problem do 
not fit the specific wishes of the rather complicated demands of adding time windows, multiple depots 
and multiple vehicles. Adding these features to a programming environment is considered too difficult 
and out of scope of this research. Next to these issues, these programs are more designed to be IT 
optimization tools rather than a GIS-based approach. 
 
And at last ArcGIS, a widely used corporate GIS program developed by ESRI inc. For routing applications 
the user is directed to an extension of ArcGIS, called network analyst (ESRI, 2018). This offers the user 
several routing functionalities, such as the travelling salesman person and vehicle routing problems. 
For the vehicle routing problems, many specifications can be added, such as time windows, multiple 

                                                           
3 https://plugins.qgis.org/plugins/chinesepostman/ 
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vehicles and depots and even penalties and restrictions on certain vehicle manoeuvres. ESRI does not 
provide solutions for arc routing, but they deliver a plugin for arc routing developed by the company 
of RouteSmart. This plugin is not free to use; licensing prices are upon request. 
 
Having considered all options, the vehicle routing problem solver of ArcGIS network analyst was the 
software of choice to accompany the gritting route  process. The choice for the ArcGIS network analyst 
is based on: 
 

• Availability within the context of the municipality of Rotterdam 

• Within the organisation it is known how to use ArcGIS, and to a lesser extent also the network 
analyst extension 

• Allowance of choice towards the user amongst many specific problems, such as different 
vehicle types, districting and time windows 

• The software has developed adequate documentation 

• Allows input from shapefiles and is able to parse network data 

• Can correctly deal with network data, network distances and network restrictions 
 
Although the advantages are considerable, the software shows some drawbacks, and were partly 
discussed with the implementation part of routing model in GISs. The biggest drawback is that the 
heuristics used by ArcGIS network analyst are propriety and therefore working as a black box. They do 
not state which solution methods they use in transportation modelling, which usually leads to users 
believing in the efficiency of the output (Mapa & Lima, 2014: p.845; Curtin et al., 2014). Also, the model 
is solved for nodes as a vehicle routing problem. The solution of this model has to be translated into 
arcs. The routing model output should be transformed and critically examined before deciding upon 
rerouting decisions. In the next section the routing workflow will be discussed, as well as the 
establishment of this routing model is introduced. 
 

4.4 The routing workflow 
The calculation of routes is incorporated into a comprehensive workflow. This workflow consists of 
thirteen phases, ranging from the creation of the network dataset to visualise the staff routing output 
(table 4.1). The model is a translation from the conceptual model (section 3.6), where the parameter 
input (depicted with a P) corresponds to the routing characteristics. The orange boxes state that these 
steps rely on data input whereas the green box represents the final output of staff routing. All grey 
boxes indicate intermediate steps within the data preparation routing processes (figure 4.3). 
 
The start of the model initializes various data inputs. This consists of road data sources such as current 
routing in the form of digitized lines, TOP10NL road segments and TomTom network data. Also, data 
considers frost spots to be loaded into the model; neighbourhood districts are imported as well. At last 
the location of the depots is added. During pre-processing various data inputs are prepared to be 
imported within the vehicle routing model. The network is created and the roads subject to gritting 
are extracted and manipulated to be correctly imported. Subsequently, the districting is created, and 
depots are added. This is finalised, as the remaining parameter settings are formulated, as setting the 
strategy & objectives and the fleet & staff assignment. 
 
At the core of the routing workflow is the creation and optimization of routes. This is achieved using 
ESRI’s vehicle routing solver, which uses an in-house developed tabu search algorithm. The output of 
the vehicle routing model is the entire route but amongst various input nodes. Next this primary data 
output is transformed from node routing to arc routing statistics, during the post-processing phase. 
Also maps are created using data visualisation techniques. Both route report and route map are 
presented to the user. 
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Figure 4.3 Routing model workflow. Depicting all fourteen steps of the routing model workflow. If the routing is considered 
OK the routing output is final. If the created route report and route map is not satisfactory, the user can change one of the 
parameters or change the data input of the model and redo the remaining phases until the user is satisfied with the routing. 

Table 4.1 Phases of the routing workflow 

i Create network dataset Adding TomTom network in ArcGIS network dataset format 

A Digitisation The translation from digitised lines into TOP10NL road parts 

B Adding attribute data Adding critical frost spots to the TOP10NL road parts 

C Transformation Transforming the TOP10NL road parts to (TomTom) road segments 

D Arc to node routing Creating nodes from arcs 

E Snapping & directionality Correctly placing nodes to the network  

F Adding depots Adding depots and characteristics 

G Sectoring Adding and constructing routing districts 

H Fleet & staff assignment Adding vehicles  

I Objective function Objective function and general model parameter setting  

J Create OD matrix & 
Solve 

Route model solving using ESRI’s in-house tabu search algorithm 

K Route traversing Create additional individual route dataset 

L Route reporting Routing model output with arc statistics 

M Route mapping Routing visualisation techniques 
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It is up to the user to decide if the formulated routing is considered good. If it is considered sub-optimal, 
and the user wishes a different outcome, one can go back to one of the earlier stages of the routing 
workflow. Three options are depicted in the routing workflow to reconsider. Firstly, the vehicle routing 
model can be re-run. The probabilistic set-up of tabu search based algorithms can possibly create 
different routing outcomes if the model is re-run. Second, one of the parameter inputs can be changed. 
Different districting, starting depot and/or gritting roads can be inserted to see if this creates a better 
routing. Thirdly, data input can be changed. Different districts, network datasets and other base data 
may result in more robust routing output. If the user is satisfied with the route reporting, then the staff 
routing is as final. 
 
The following sections describe the routing workflow more in detail. Section 4.5 describes the data 
input, section 4.6 dives into each of the phases of the routing workflow, whereby section 4.7 looks at 
the initial vehicle routing model parameter settings.  
 

4.5 Data description 
Three road data sources are used during the modelling process: (i) the current routing, (ii) the TOP10NL 
road segments and (iii) the TomTom Multinet road data. Besides these three datasets three additional 
datasets are available. This is an (iv) depot dataset, an (v) additionally created asset management 
dataset describing critical frost spots, which is built on top of the TOP10NL road segment dataset. 
Lastly, a (vi) neighbourhood dataset, which includes the municipal districts of Rotterdam and is used 
for road segment sectoring. Every one of these datasets contains information and capabilities which 
are needed in the process of route making and will be briefly introduced. 
 
Routing dataset: current routing  
The current routing consists of routes, which are shaped as digitised lines; they contain information 
about route number and category (e.g. access route, main motorway route). Multiple digitised lines 
exist per route; each line segment indicates if this route part is used as a salt spreading route, or as a 
connection route. Both begin and endpoints of routes are given, together with the ID of the line 
segments they can be used to discover and reconstruct individual trails. 
 
For now, the current routing serves the purpose of generating routing instructions on A3 printed maps. 
Both data structure and layout, serving the paper map production are not designed for maintaining 
the road assets, nor for creating automated routing. However, the current routing contains important 
data about the actual roads requiring service and type of vehicle. This information can be of value for 
creating new routing Taking a closer look at the distinction between a salt spreading route and 
connection route reveals many small digitisation errors. This implies that the roads subject to 
spreading, the direction and road passing have to be manually checked before routing calculations will 
be activated.  
 
Asset management dataset: TOP10NL road parts 
The TOP10NL is the 1:10,000 topographic map of the Netherlands. It consists of various object classes, 
each representing a topographic object of roads, buildings but also an area classified by a theme. Many 
public organisations, including the municipality of Rotterdam, are obliged to have their part of the 
TOP10NL in place and keep them up-to-date. For our purpose the interest lies within the road parts 
object class of the TOP10NL, which always contains multiple geometric aspects (figure 4.5). As a next 
step to the road surface, lines, point, centre point and centre lines can be constructed, where only the 
road surface geometry is used. When it is referred to road parts, road surface geometry is meant. 
Furthermore road parts object class contains several interesting attributes, as at the other side road 
type and main traffic use may help in the digitisation process and prevent selection of wrong road 
parts. Other attributes such as infrastructure type and separated roadways may help in the translation 
from road part into a network dataset. 
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Using the TOP10NL as an asset management dataset has several advantages. First, the TOP10NL is one 
of 12 key registers of the national Dutch key register system, which was implemented to have Dutch 
governments organize (and use) their data more efficiently. In daily practise this implies that the 
TOP10NL is well documented and knowledge of using and maintaining the dataset is guaranteed within 
the organisation. These benefits lead to a more efficient and sustainable use of gritting route data. . 
Second, the polygons can be modified if this is wished upon. Third, other road asset management data 
can be stored on the same polygons. This makes it easier for the road authority to have an integral 
approach for road maintenance. Fourth, in the future the TOP10NL is planned to be linked to other 
key registry systems in order to reach an even more refined asset management. A link with the Key 
Register Large scale topography (basisregistratie grootschalige topografie) would lead to better 
geometric properties of road parts. In a next phase this can be of interest for extracting road width 
and road surface properties, which allow asset managers for even more precise estimations of salt 
usage. Fifth, the data is owned by the municipality. Storing asset management on the network dataset 
would imply that the municipality is attached to the network dataset supplier. If one would like to 
terminate the contract or share the data for public usage, problems might occur. Sixth, having a way 
to link asset management datasets to a network dataset might be interesting for other applications 
within the municipality which require routing, e.g. the routing for street sweeping and/or visual road 
inspections. Also, other datasets could be linked, like the tree dataset for routing tree trimming.  
 
 
 
 
 
 

 

 

 

 

 

 
 

 
 

 
Asset management dataset: critical frost spots 
Although the TOP10NL road part data were introduced as the asset management dataset, it is sheer 
impossible to add every attribute of interest directly into the road parts. One of these attributes is 
critical frost spots. Critical frost spots are those places which could need high priority due to 
slipperiness. Infrastructure like bridges, shadowy places and spots where earlier accidents have taken 
place, are the basis for this category. Owing a dataset which describes the exact positions of these 
places is of great importance, because they are used to prioritize links in existing routes. Not obtaining 
precise information may result in data generalisation or location errors, failing to take adequate 
preventive measures. Thus, registration should be correctly organized, maintained and applied to the 
routing calculations. Critical frost spots here are used as an example how data can be linked to the 
main asset management dataset, the TOP10NL. In daily practice however, many other datasets can be 
linked as well, e.g. weather information, temperature sensors and/or additional road information. 

Figure 4.5 Different geometries of the TOP10NL road part.  
This thesis only uses real geometry: polygons, highlighted in 
green (source: PDOK, 2017). 

Figure 4.4 Wrong digitized routing. The red line 
indicates a connection route which is correctly 
depicted, while the other connection (2x blue line) on 
the right is not highlighted in red. 
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Asset management dataset: Depots 
All depot locations are created and stored in a 
point shapefile and snapped to the network 
dataset. Already created depots do get 
additional attribute data which is inserted in 
the routing problem, such as maximum 
vehicle capacity and time window settings. 
These are used to set the vehicle routing 
problem within the vehicle routing workflow. 
The depots are used as start and as endpoint 
of the route for vehicles (figure 4.6). 
 
 
 
Network dataset: TomTom Multinet 
Both routing and asset management dataset are not suitable to analyse networks. To enable network 
analyses a third type of dataset is needed, i.e. a network dataset. Network datasets consist of edges, 
arcs and junctions. Together with attributes, which control the navigation over the network and other 
attributes they establish a network dataset (ESRI, 2017b). They contain information about the network, 
such as length, speed limit, road hierarchy and travel time. Additional information is given about 
junctions, like junction type and turn restrictions. Several of these datasets exists, both from open 
source and commercial providers. Familiar open source network datasets are for example 
OpenStreetMap, or the Dutch National Roadfile (Nationaal Wegen Bestand). Popular commercial 
datasets can be found within TomTom Multinet and NAVTEQ NAVSTREETS.  
 
The municipality of Rotterdam owns a license in order to use the TomTom Multinet dataset, which is 
their network dataset of choice. The reason for using the TomTom Multinet is that, unlike open source 
alternatives like the Dutch National Roadfile, which contains information about estimated travel times. 
These are of importance to route vehicles within the two-hour time limit. Over- or underestimation of 
travel times can lead to violation of the time windows or inefficient use of vehicle time capacity. 
Secondly, the TomTom dataset contains additional tables which provide in special driving manoeuvres 
as well as restrictions. Having these additional data geometrically joined benefits the providence of 
realistic driver routes. Finally, a licensing contract enables contractors to receive reliable up-to-date 
routing when needed. Additional products can be bought if needed, like more accurate and real-time 
speed profile updates. For the detailed data model behind TomTom Multinet, in which the relationship 
between the shape files and attribute data is described, the reader is referred to appendix B. 
 
Sectoring dataset: Neighbourhood districts 
There are several ways to sector links for routing. One way is the use 
administrative areas. In the Netherlands these administrative areas are 
dealt with on different spatial levels. Mostly used is the CBS 
neighbourhood classification. But for sectoring purposes, the 
classification seemed too large and therefore the more detailed 
administrative areas of sub neighbourhood districts are used (figure 
4.7). An industrial area just above the Oudeland and Tussenwater is not 
depicted in the map. A district name for this industrial area was created, 
being Nieuwe Gardering. Furthermore, there are some roads which lie 
outside of the districts. These are joined into a new district called 
Pernis.  
   
 

Figure 4.7 Neighbourhood districts 
Hoogvliet. 

 

Figure 4.6 Depot Giessenweg [author’s own picture] 
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4.6 Modelling phases 
The workflow as shortly introduced in section 4.4 consists of thirteen phases. The first four phases 
consist of correctly translating current routing dataset to an asset management dataset and finally to 
a network dataset. For technical details regarding these steps taken in ArcMap the reader is referred 
to appendix C. The next six phases consist of setting up the routing model. The last two phases deal 
with validation and visualisation of the staff routing.  
 
Phase i: Creating network dataset 
To be able to use commercially available street data within the calculations of ArcGIS Network Analyst, 
a network dataset must be created. This process can be time-consuming and requires a thorough 
understanding of network creation. For this reason, ESRI has released a street data processing tool on 
GitHub, which allows popular street products of TomTom Multinet to be automatically built into a 
network dataset. The tool processes shapefile data from TomTom Multinet by importing the street 
feature classes into a file geodatabase and adding fields for modelling overpasses/underpasses, one-
way streets, travel times, hierarchy, and driving directions. Also feature classes for modelling turn 
restrictions and signpost guidance are created. The output of the procedure delivers a network dataset 
with edges and junctions. All three line datasets are provided with streets, signpost information and 
restricted turns. 
 
After its creation the network can be used in ArcGIS, this does not mean that it is final. There are 
several occasions conceivable in which one would wish to (manually) adjust the network. Reasons like 
adding yet non-existent roads, removing roads and changing road attributes such as directionality, turn 
features and/or travel times. The most important reason however is to simplify the network. If the 
number of visiting arcs increase, vehicle routing problems do become more complex to solve. This step 
needs to gather all arcs in need of gritting before one can start with simplifying the network in a later 
phase. Due to commercial street data and complex network building functionalities, it was not possible 
to adjust the network. This means that the basic network is used as-it-is. No features are added, 
changed or simplified. Although this gives no direct problems, it does have practical implications for 
adopting the routing workflow.  
 
Phase A: Digitisation 
The first phase consists of digitizing the current route into the TOP10NL road parts, for which there are 
two main aspects: the selection of the correct TOP10NL road parts (false positives or false negatives 
will have to be manually added or deleted) and the ´correct translation´ of information about the road 
parts in the form of attribute data. For the road parts several attributes can be of interest to add.  
 
The first phase consists of digitizing the current route into the TOP10NL road parts. For perfect fitting 
of the two datasets a commonality is required. This’’ join’' can be made on different aspects of the 
dataset, like spatial, attribute or unique field characteristics. Exploring the dataset revealed that the 
combination of a spatial join with attribute characteristics filtering led to the best overall result. Used 
attribute filters are those for the fields of motorized traffic and parking places. With this method not 
all required road parts could be selected. A total of 15 road parts are manually removed and 5 are 
added, approximately a 2% error rate. The total process resulted in a total of 999 selected road parts 
(table 4.2). 
 
The second phase adds attribute data to the TOP10NL road parts, of which several can be of interest, 
such as (i) the gritting class (main route, biking route), (ii) how many passing times does the road part 
needs to be gritted (ii) what is the original route number, (iv) how many times is the road used in the 
original connection routes (v) what are the sequence numbers of a road part inf the original route. 
Attributes (i) and (ii) are needed for the newest route model whereby the last three attributes are 
needed to calculate the efficiency of the current routing. 
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Table 4.2 Digitisation road parts 

 Action Count 

Spatial join Add 1064 

  1064 

Attribute: Main road usage   

Bicycles, mopeds Remove 37 

Motorized traffic Remove 15 

Pedestrians Remove 1 

  1011 

Attribute: Road type   

Parking area Remove 2 

  1009 

Manually edited   

Should not be spatial joined Remove 15 

Not within spatial join Add 5 

   

Total remaining road parts  999* 
*Consisting of 512 links and 487 junctions 

 
Unfortunately only the first attribute (gritting class) could be digitised from the original lines. This 
resulted in the manual adding of the gritting passing times for roadways. The remaining three 
attributes are relevant for calculating current gritting times and they will be added but only in phase 
D.  
 
Phase B: Critical frost spots 
The TOP10NL road part data layer is used as the main asset layer as digitised in phase A. It contains 
two additional attributes: the gritting class (main route, biking route etc) and how many passes are 
needed for gritting. In this stage supporting datasets can be linked onto the road part dataset. One 
dataset of interest to be linked is critical frost spots, due to their high priority, due to slipperiness. 
Infrastructures as bridges, shadow places and spots were earlier accidents have taken place may also 
fall within this category.  
 
To account for the critical frost spots a new dataset layer has to be created. New objects can be created 
either by adding a polygon, line or point object (figure 4.10, next page). These can be linked to the 
TOP10NL road parts via a spatial join. Adding the spots directly to the road part would result in 
inaccurate and generalized data, and these spots cannot be adequately recognized.  
 
Phase C: Transformation 
The main objective in phase C is to select the right components of the underlying TomTom network 
dataset. This starts with creating a spatial join between the TOP10NL road parts and the TomTom 
street network and resulted in a selection of 1144 links (table 4.3). At this moment, there are no criteria 
in either TOP10NL nor TomTom dataset to make a finer selection. Therefore, all selected TomTom links 
which are not correct have to be manually selected and deleted. Over 400 links were removed easily, 
after detection wrong. During this transformation, it was possible to select all junctions of the TomTom 
dataset, represented here as points. This step is not done in this moment, whereas selecting all 
junctions serviced for gritting and adding them into the routing model would create a much bigger 
routing problem and thus harder to solve. For this reason only links are used in the routing model. For 
big intersections however links are used between multiple TomTom junctions. These links were joined 
to the nearest TOP10NL links. The spatial join also missed 26 TomTom links, and were added to the 
dataset, which in the end resulted in a total of 758 links. 
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Table 4.3 Digitisation TomTom road links 

 Action Count 

Spatial join Add 1144 

  1144 

Manually edited   

Should not be spatial joined Remove 412 

Not within spatial join Add 26 

   

Total remaining TomTom links  758 

 
Phase D: Arc to Node Routing 
After selecting all TOP10NL road parts (phase A) and all relevant TomTom links (phase C), the attributes 
from the TOP10NL road parts will be linked to the TomTom dataset. From the TOP10NL road parts only 
those parts which represent links are used; road parts which represent junctions are neglected. Joining 
the road part junctions to TomTom links will result in many digitalization errors and ultimately in 
wrongly addressed routing. The joining of TOP10NL road part links to TomTom links is not 
straightforward: some TOP10NL road part links represent several TomTom links, or the other way 
around. This concept of a ‘many-to-many join’ is illustrated by means of an association (figure 4.8).  
 
 

 
 
 
 

 
One-to-many road parts are associated to one-to-many links. This illustrates by design that it is not 
possible to have road parts which are not associated to any TomTom links. Furthermore any road part 
is always associated to a TomTom link, whereby all TomTom links represent one-to-many road parts. 
This ensures that all selected links are incorporated into the routing model. Testing to apply this 
association led to many digitisation errors, and the geometry of both the road part and TomTom links 
is changed into points for better digitisation results (figure 4.9). Next to the advantage of a better fit 
for attribute transfer, the TomTom links had to be converted to points anyway. This is due the fact that 
the model uses nodes (points) instead of links (lines) as input for routing calculation. 
 

 
 
 
 

 
 
 

 
 

TOP10NL Road parts (512) 
+ Geometry: polygon 

 
 
 

TomTom links (758) 
+ Geometry: line 

Associated to 
 

1 … * 
 
          1…* 
 

 

 

 

TOP10NL Road parts (512) 
+ Geometry: point 

 
 
 

TomTom links (758) 
+ Geometry: point 

Associated to 
 

1 … * 
 
          1…* 
 

 

 

 

Figure 4.8 Association between TOP10NL Road parts and TomTom Links 

Figure 4.9 Reconfigured association between TOP10NL Road parts and TomTom Links 

Figure 4.11 Manual checking if the centre of the TOP10NL 
road parts (red points) connect to the centre of the  
TomTom lines (green points) via the black plotted line. 
 

Figure 4.10 Adding critical frost spots (blue polygon) 
for phase B.  
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The transfer of attributes of the TOP10NL road parts to the TomTom links is performed by multiple 
sessions; all 758 TomTom links are connected to the nearest TOP10NL road part as well as their 
connection. The latter is manually checked by means of a visual inspection (figure 4.11, previous page). 
Nine TomTom links were wrongly connected and therefore coupled to a different TOP10NL Road part. 
All remaining TOP10NL road parts, not coupled yet, are identified and selected, and linked to the 
nearest TomTom link. Again, this connection between the remaining TOP10NL road parts and the 
TomTom links is manually checked for digitisation errors. Of the 96 remaining TOP10NL road parts, 26 
were manually edited to link to another TomTom link.  
 
As a next step both datasets are linked to each other. For all TomTom points the correct TOP10NL road 
part is added as an attribute to the TomTom link table. To join the table containing the TomTom links 
to the TOP10NL road parts, one has to be sure that all attributes of the TOP10NL road parts are 
transferred into TomTom links (figure 4.12). For the 1:1 relationship (green) and *-1 relationship (blue) 
this is effectuated by means of an attribute join. The TOP10NL not being joined yet have been collected 
in a third database and joined via a related relationship database, ensuring the 1-* cardinality (orange). 
As a result, all TomTom links have the correct attribute information of the link itself and the 
corresponding TOP10NL road part. 
 

 
Figure 4.12 Data structure between TOP10NL road parts and TomTom links tables 
 
Phase E: Snapping & directionality 
After converting all TomTom links into points and connecting them to the significant TOP10NL road 
part, TomTom midpoints can be snapped to the network. This snapping cannot be carried out directly 
onto the network. The network representation is a simplification of the reality and features within the 
network are represented in different ways (figure 4.13). Currently one node has to be placed onto the 
network. This is fine for simple roads, which has to be serviced only once, via either a positive, or 
negative direction. Roads which require positive and negative passing, represented as a simple line 
features, require special treatment (figure 4.13c). To deal with this two instead of one TomTom 
midpoint is placed. One midpoint is serviced on the right side and the other on the left side of the road. 
This makes the road being serviced in both directions. 
 

 
 
 

Figure 4.14 Global turn evaluator. Figure 4.13 Network representations (a) in reality,  
 (b) in the underlying TomTom data structure and 
(c) in the feature representation within the GIS 
environment  
(figures derived from Hajibabai, 2014). 
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To account for this, there is again, no general rule or attribute in the dataset which can account for 
this. Streets may need treatment in both positive and negative directions. Again, the solution of this 
problem is manual labour. The current routing is loaded into ArcMap and looked through the current 
classification of gritting and connection roads. From this classification, those links are selected (by 
means of the TomTom midpoint) which needs treatment in both positive and negative direction. The 
result of this analyses are documented in maps and can be found in appendix D. In total 109 nodes 
have been duplicated, bringing the total up to 906 nodes. Creating additional nodes comes with an 
ever increase in the computational complexity of the combinatorial optimisation problem. This results 
in an increased processing time for solving. One last action before snapping the nodes to the network, 
is to set a time window. All the roads must be serviced within two hours, which is thus inserted for all 
nodes. Vehicles cannot add any nodes after the two hour time window. Lastly, in the input phase the 
nodes could not be added due to that some nodes did share a common identifier. To solve this the 
OBJECTID of left, right and both way nodes are recalculated. For right nodes 10000 is added and left 
nodes 20000 is added. Result is an OBJECTID2 class which contains unique object ID’s for insertion into 
the routing model.  
 
Phase G: Depot 
The depots are represented by points, which are snapped to the network. The depot starting time is 
added as an attribute value of 00:00:00. Any time can be used, since the network dataset does not 
contain spatiotemporal traffic data and/or dynamic historic travel data.  
 
Phase H: Fleet & Staff assignment 
The fleet & staff assignment is quite straightforward. Two members of the team are assigned to the 
two vehicles. The vehicles start at the Giessenweg depot and they also finish there. The time is set on 
zero and starts running when the driver leaves the depot. Then the time window is set on the service 
nodes to be served in a 2-hour time window. This means that no end time is needed to set on the 
vehicles. ArcGIS Network analyst also requires you to set the number of nodes which can be serviced, 
with is set to the maximum of a thousand nodes.  
 
The fleet and staff assignment also incorporate some kind of view on the time it takes for the driver to 
perform manoeuvres. For this purpose the global turn evaluator is used to penalise different types of 
turns. The straight turn and U-turn have a 60 degree turn angle range, whereas the left and right both 
have a 120 degree turn range (figure 4.14, previous page). The standard values are set a 3 second turn 
penalty on right turns, 5 seconds on left turns, 30 seconds on U-turns and 2 second for crossing straight 
lanes which is considered a normal to high penalty (O’Connor, 2013; Price, 2008). A few remarks on 
the settings on these values: left turns are given a higher penalty than right turns, because they are 
more difficult to make and create more interference with the traffic. A 30 second penalty is given on 
U-turns because of the large length and width of the salt spreading vehicles. U-turns are therefore only 
allowed to be taken at intersections or dead ends, not on the middle of the road. When the vehicle 
drives straightforward on an road junction only a 2 second penalty is rewarded. Intersections or road 
crossing with different road hierarchies require alertness from the driver and possibly slow down the 
actual driving time in case other traffic inserts into lanes. 
 
Phase G: Sectoring 
Now that all the nodes have been placed on the network, it is time to assign the nodes to different 
vehicles. The standard option is to not predefine sectors. In this case, nodes are inserted and replaced 
between vehicles by the tabu search algorithm. Sectoring can replace this process by predefining which 
nodes are serviced by which vehicle,  either by hard or by soft boundaries. Hard boundaries do not 
allow nodes to be replaced between vehicles; the vehicle is bounded by the sector it is assigned to. 
Soft boundaries allow vehicles to service nodes outside the initial district. Servicing outer nodes 
however comes with an additional cost which is put on top of the cost function, which is based on 
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Euclidean distance from the route district (ESRI, 2017b). The further away nodes are from the vehicle 
district, the less chance it has on being assigned to the specific vehicle routing. 
 
Sectors are based on administrative or transportation relative factors. As input, the administrative 
areas of the Hoogvliet sub-neighbourhoods are chosen. These consist of nine subareas and one area 
which falls outside of Hoogvliet. Because there are only two vehicles available for serving ten areas, 
the areas have to be merged into two coherent blocks. Merging these areas is based on the adjacency 
of administrative districts, but also transportation related factors are taken into account. Sectoring can 
have a significant impact on the quality of routing and the workload balance between routes. To 
account for this, not one but two different sectoring outlines are made, making it possible to compare 
different sectoring and get a better understanding on how sectoring influences routing. For 
comparison to the manual drafted routes districts are formed which match closest to the original 
routing.  
 
Phase I: Strategy & Objectives 
The main strategy of the municipality of Rotterdam is set to reduce driving minutes. This does not 
mean other factors to be irrelevant. The municipality would also like to see a reduction in the total 
vehicle mileage. This variable will also be tracked and noted in the results, to see if there is a balance. 
However, the objective is not minimised by the routing algorithm. Rotterdam also would like to explore 
the use of less vehicles and drivers, but for Hoogvliet no viable solution is found, due to the two-hour 
time window.  
 
To incorporate the strategy of reducing driving minutes into the routing model an objective function 
is used. This allows the model to minimise driving minutes for a given input. For evaluating the routing 
solution the follow model is established:   

 
𝑇𝑇𝑚    =     𝑇𝑇start + 𝑇𝑇end +   ∑ (TTSRSi + TTNSRSi )𝑛

𝑖=1   + ∑ 𝑡𝐿𝑡𝑢𝑟𝑛𝑠i
𝑁𝐿𝑡
𝑖=1  + ∑ 𝑡𝑅𝑡𝑢𝑟𝑛𝑠i

𝑁𝑅𝑡
𝑖=1  + (4.1) 

    ∑ 𝑡𝑈𝑡𝑢𝑟𝑛𝑠i
𝑁𝑈𝑡
𝑖=1  + ∑ 𝑡𝑆𝑡𝑢𝑟𝑛𝑠i

𝑁𝑆𝑡
𝑖=1     

 
Where: 
𝑇𝑇𝑚  Total travel time in minutes 

𝑇𝑇start    Travel time from the depot to the first service road  

𝑇𝑇end    Travel time from the last service road to the depot  

𝑇𝑇SRS𝑖    Travel time for the i-th service road segment  

𝑇𝑇NSRS𝑖    Travel time for the i-th non-required service road segments 
n    Total number of road segments in the route 

No  Total number of road segments outside the service district 

NLt    Number of Left turns 

tLturns    Time penalty on left turns 

NRt    Number of right turns 

tRturns    Time penalty on right turns 

NUt    Number of U-turns 

tUturns    Time penalty on U-turns 

NSt    Number of straight turns across intersections 

tSturns    Time penalty on straight turns across intersections 
 
Phase J: Create OD matrix & Solve 
Phase A-I prepared all parameters and the objective function for the vehicle routing problem. In phase 
J, the vehicle routing problem is solved by the ArcGIS network analyst in a series of steps. The first step 
is that an origin-destination (OD) matrix is constructed from all the inserted TomTom midpoints 
together with the depot. ArcGIS network analyst uses Dijkstra’s algorithm to create the shortest pairs 
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between all points, taking into account the network distances as specified by the network dataset. The 
second step involves the creation of an initial solution by inserting orders into one of the vehicles. The 
order is inserted to the most appropriate route (ESRI, 2017a). During the third step orders are replaced 
from position within a route and exchanged from one route to another. This exchanging of orders is 
based on the tabu search algorithm developed in-house by ESRI (ESRI, 2017a). The solving time for the 
three steps from the vehicle routing problem tabu list search differences per instance. In this case 903 
nodes have been placed on to the network, two vehicles and some restrictive factors like time 
windows. Solving the vehicle routing problem on this instance takes between 1.5-9 hours on a desktop 
computer with an Intel i5 2500CPU @ 3.30GHz and 4.00 GB installed memory (RAM). The large time 
differences is caused by the number of nodes added to the vehicle routing problem and if additional 
conditions like districting is used. 
 
When the tabu search algorithm achieved the local optimum, a total of three outputs are generated. 
Starting with the calculated route. This consist of one line and has some attribute data, like starting 
time, ending time and length. Secondly the list of orders, which contains information about the 
sequence of orders serviced and the time of servicing. Thirdly, the depot visits are listed, here the 
depot is visited two times; at the beginning and ending of the service. Although the vehicle routing 
problem is solved and the route directions are given, some last work has to be done. This will now be 
dealt with in the post-processing steps. 
 
Phase K: Route traversing 
Before one can report the routing and visualise the map, some additional outputs have to be created. 
This consists of turn, edges and junction information. To retrieve this information the create turn 
feature class tool is used. Together with the output created in Phase J: Create OD matrix & solve, all 
the necessary data is created for the route reporting. However, all data outputs concerning routing are 
created lumped together in their respective datasets. This means that, for example, the turns of all 
vehicles are delivered in one dataset. To create additional datasets which only contain the given data 
of a single vehicle, a split layer by attribute script is used. This created the needed datasets and exports 
these into a file geodatabase.  
 
Phase L: Model reporting 
Subsequently, the solution is made with the use of 
node routing, instead of arc routing. Placing a node 
on each arc makes sure that each arc gets serviced. 
However, when the model passes the node, the 
model output does generate information about the 
service between node to node. The interest here, 
however lies in the information about traversing 
arcs. The results need to be translated to arc routing 
and to be plotted on maps before one can decide 
upon the final routing. For the model report a 
template is created (figure 4.15). Several 
components are extracted and calculate from the 
route output and route traversing and do 
correspond with the objective function (formula 
4.1). These are highlighted in blue. The seconds are 
displayed in decimal time (1/100th of a minute).  
 
The five components (i) Time from depot to first 
service road, (ii) Time from the last service road to 
depot, (iii) service time, (iv) deadhead time and (v) 
manoeuvre time do add up to the total travel time. Figure 4.15 Route report example 
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The manoeuvre time is broken down to left turns, right turns, U-turns and straight across intersections. 
The manoeuvre error margin is added because the vehicle routing travel time output did not 
correspond with the route traversing data. This was caused by that additional penalties triggered by 
the TomTom restricted turns input were not added to the objective function. These errors are 
subtracted because it seems that they are not calculated by the objective function. The model 
reporting seemed hard to automatically generate from the route calculation onwards. Therefore the 
route reports are manually created and calculated using the route output and route traversing 
datasets. In the discussion the reasons for failing to automate the model reporting process are 
discussed. 
 
Phase M: Route Mapping 
Next to the route reporting a routing map is produced. The route maps are designed manually as well. 
An example of the final product can be found in figure 4.16. The visualisation of the route map is 
inspired by the current gritting maps of the municipality. For the routing arrows are added to the route 
line. With the use of a cartographic offset the single road lines are divided to left and right side of the 
road. Beginning and endpoints are added for when the gritting vehicle starts gritting the first road and 
the gritting of the last roads. Finally, all required arcs are added to the map, which helps displaying 
which arcs are not passed by this vehicle. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 4.16 Route map example 
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4.7 Scenarios 
In order to see what type of routing is interesting, four scenarios are developed. Each of the scenarios 
highlight a different aspect of the route creation; from creating more time efficient to more compact 
and sustainable routes. The scenarios are: 
 
Scenario 1: Current routing The current routing is loaded into the model. This is meant as a 

understanding of the current routing performance, as well as a 
benchmark on how the other scenarios and calculations turn out in 
perspective to the current routing. 

Scenario 2: New routing The new routing does not impose any restrictions on any of the two 
vehicles or on the sequence of the gritting routes. The algorithm is set 
to search for the most time efficient routing. 

Scenario 3: Sectoring With the help of administrative districts, the routes are categorised in 
sectors for creating more compact routes. Segments which fall outside 
the sector can still be included and are allocated to a nearby sector. 

Scenario 4: Node reduction The node reduction scenario reduces nodes between two gritting 
route junctions.  

 
The routing model is initially developed to suite the new routing scenario. To calculate the current 
routing, node reduction, balancing and sectoring scenario some slight modifications have been made 
in the routing workflow.  
 
Scenario 1: Current routing  
To calculate the vehicle routing model it is necessary to feed the current routing into the proposed 
routing model. For this some slight modifications are done to the routing model workflow. Because 
the routing is already there, the vehicle needs to be guided over the TomTom network. This is done by 
using waypoints in the form of TomTom midpoints, and assign a sequence number. The option 
‘preserve sequence and relative order’ is used by assigning the orders to the route. The route outcomes 
is evaluated if the route made the exact same route as the current routing. Some routing was different, 
but the miscalculations were small compared to the overall time. The differences were due to 
unjustifiable turns. It could be fixed if one could modify the network. As already mentioned, this is not 
possible.  
 
Scenario 3: Sectoring 
To the model the two administrative sectors are added. Not all nodes fall within the preassigned 
sectors. It is up to the algorithm to assign the remaining nodes onto one of the vehicles. The sectoring 
is also configured with soft boundaries. Not all nodes within a sector have to be assigned to that 
specific sector but can be placed at adjacent sectors as well.  
 
Scenario 4: Node reduction 
For the node reduction all the required arcs are dissolved into one line. This line is then split into 
separated polylines in case they cross, which created 254 arcs. Of these arcs 26 need to be gritted on 
both sides, resulting in 280 nodes. One disadvantage is that the network dataset is not modified to 
these new arcs. This is still using the 904 individual arcs. In order to minimize wrong routeing, all arcs 
which are not subject to gritting are made non-traversable. This excludes the possibility to use non-
required neighbourhood roads.  Excluded from these non-traversable arcs were motorways and 
regional roads. This made travelling to and from the depot possible. 
 
 
 
 



54 
 

4.8 Parameter settings overview 
In the model many parameters are used. Many of these parameters are already discussed in setting 
up the model but are summarised here to provide an overview (table 4.4). 
 
Table 4.4 Parameter settings overview 

Model parameter Details Initial value 

TomTom Road segments (orders) Name ID 

 Service Time 0.0 

 TimewindowStart 00:00:00 

 TimeWindowEnd 02:00:00 

 Assignmentrule Override 

 CurbApproach No U-turn* / Left** / Right** 

   

Depot Location Giessenweg 

   

Sector design (route zones) RouteName -  

 IsHardZone -  

   

Fleet & staff assignment Name 1 /2*** 

 StartDepotName Giessenweg 

 EndDepotName Giessenweg 

 EarliestStartTime 00:00:00 

 MaxOrderCount 1000 

 U-turn policy Only allowed at intersections and 
dead ends  

 Penalty on right 
turns**** 

3 

 Penalty on left turns**** 5 

 Penalty on U-turns**** 30 

 Penalty on straight across 
intersections**** 

2 

   

Strategy & Objectives Time Attribute Minutes (Minutes) 

 Distance Attribute [do not fill in] 
*if the road is passed once. **If the road is passed in both directions two orders are inserted. Insert Left for 1 
order and right for 1 order.  *** two vehicles are used, named ‘1’ and ‘’2’. **** Using the global turn evaluator 

 
Differences in parameter settings for the current routing scenario and sectoring scenario are given 
the following parameter input (table 4.5-4.6).  
 
Table 4.5 Current routing scenario 

TomTom Road segments (orders) Assignmentrule Preserve order and relative 
sequence 

 
Table 4.6 Sectoring scenario 

Sector design (route zones) RouteName 1 / 2 

 IsHardZone no 
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5. Results 
 

This chapter is about elaborating the results that were obtained from running the various scenarios 
formulated in section 4.7. Each scenario except the current routing scenario reflects a modification or 
decision which interferes with the vehicle routing (section 5.1-5.4). The scenarios are created based 
on the need of the municipality of Rotterdam and technical route modifications. The route report is 
displayed in this section, whereby the route map displays both routes. At the end of this section the 
scenarios are presented in an overview and the models will be reiterated to check for model scenario 
accuracies.  
 

5.1 Current routing 
In the first scenario the current routing is evaluated. It is necessary to have knowledge over the current 
situation before examining other scenarios. The two routes which have been imported in the routing 
model are the main routes HR_044 and HR_045. The results have been added and the total travel time 
is summarized (table 5.1). The total travel time consist of 197.52min, which is around 3 hours 17 
minutes. The travel time is divided between two vehicles, one taking 2 hours and 1 minute and the 
other 1 hours and 17 minutes to drive from start to finish at the Giessenweg depot. 
 
Table 5.1 Scenario 1: Current Routing  

Time route  Time route 
 

 
HR_044  HR_045 Total 

Start time 00:00:00 00:00:00 
 

First service road arrival time 00:11:18 00:11:59 
 

Last service road departure time 01:04:41 01:45:09 
 

End time at depot 01:17:18 02:00:14 
 

    

Time from depot to first service road (min) 11.31 12.00 23.31 
Time from the last service road to depot (min) 12.60 15.07 27.67     

Service time (gritting) 33.66 58.75 92.42 
Deadhead time  8.26 5.56 13.82 
Manoeuvre time 11.47 28.85 40.32     

Number of left turns 33 25 58 
Left turns (min) 2.75 2.33 5.08 
Number of U-turns 1 7 8 
U-turn (min) 0.5 3.5 4 
Number of right turns 47 125 172 
Right-turn (min) 2.35 6.25 8.6 
Number of straight across intersections 176 505 681 
Straight across intersections (min) 5.87 16.83 22.70 
Manoeuvre error margin - -0.23 -0.23     

Total travel time (min) 77.30 120.23 197.52 
Total distance (kilometres) 54.90 77.46 132.36 

 
A few things can be noticed for the current routing. At the total service time (gritting) a total gritting 
time of 92.42min is clocked (table 5.1). This is more than the 86.68min that is expected from all the 
required arcs of serviced. This difference is explained by that the routes is categorised using the service 
arcs/deadhead arcs based on the data of the current routes of the Municipality of Rotterdam. Due to 
that the maps are constructed manually, arcs have been wrongly labelled as serviced, while they have 
been already serviced by another route. These wrong categorisations regularly happen at 
roundabouts. The total difference consists of 5.74min.  
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Figure 5.1 Current gritting routes of Hoogvliet 

 
Also, the route could not be perfectly inserted into the routing model. A few exceptions are used to 
correctly deal with the problem at hand. This occurred for example at the Laning way, where the 
current routing wrongly crosses a one-way street. Therefore, the routing model routed this to the 
Laning road, deadheading the arc to enter the street in the other direction (figure 5.2). In the other 
routing scenarios this will also be done. This problem is considered unlikely to happen, but not critical 
in further examination of the routes.  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.2 Fault in modelling current routing. (a) Route HR_045 makes an illegal one-way move at the Klenke road. (b) 
Detour on the Laning road, passing the Klenke road the other way around. 

A         B 
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Overall the current routing is sufficiently implemented as the first scenario. The other three scenarios 
will be compared to this outcome, to see if more optimal routing can be created.  
 

5.2 New routing 
The new routing does not impose any restrictions on any of the two vehicles or on the sequence of the 
gritting routes. The algorithm is set to search for the most time efficient routing. The outcome is 
summarized in table 5.2. The total travel time consist of 208.25min, a 5.4% increase to the current 
total gritting route time of 197.52min. Having the possibility to endlessly optimize for better routing, 
the scenario creates an outcome which performs worse than the current routing scenario. 
 
Table 5.2 Scenario 2: New Routing 

 
For the procedure that is followed one may want to look at the routing table. The last arc gritted at 
route one is 01:59:21. This means that route one did not have enough capacity to take on additional 
nodes. In the swapping process it could for some reason not be taken into account. This lead to the 
routing in total being a little awkward. Especially the second route touched upon some required arcs, 
but is driving through the whole of Hoogvliet, only servicing a relative small subsection of the arcs 
required (figure 5.4, next page). For an indication on how the routing algorithm operates a closer look 
is taken. Two times the route exits the motorway to only grit one route and goes back to the motorway. 
It takes time to enter the motorway ramp, grit a few arcs and then go back to the same motorway via 
another ramp to continue the journey. This routing procedure can be considered suboptimal.  
 
 
 
 

 
 

 
Time route 1 

 
Time route 2 

      
Total 

Comparison 
Current routing 

Start time 00:00:00 00:00:00 
 

 
First service road arrival time 00:10:42 00:11:15 

 
 

Last service road departure time 01:59:21 01:04:15 
 

 
End time at depot 02:12:31 01:15:43 

 
     
 

Time from depot to first service road (min) 10.71 11.26 21.97  -5.7% 
Time from the last service road to depot (min) 13.17 11.47 24.65  -10.9%     

 
Service time (gritting) 55.99 30.69 86.68  -6.2% 
Deadhead time  17.07 10.43 27.50  99.1% 
Manoeuvre time 35.58 11.87 47.45  17.7%     

 
Number of left turns 68 23 91  
Left turns (min) 5.67 1.92 7.58  49.2% 
Number of U-turns 8 6 14  
U-turn (min) 4 3 7  75.0% 
Number of right turns 135 58 193  
Right-turn (min) 6.75 2.9 9.65  12.2% 
Number of straight across intersections 585 145 730  
Straight across intersections (min) 19.50 4.83 24.33  7.2% 
Manoeuvre error margin -0.33 -0.78 -1.12      

 

Total travel time (min) 132.52 75.72 208.25  5.4% 
Total distance (kilometres) 74.55 62.17 136.72  3.3% 
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Figure 5.3 Gritting routes Hoogvliet in the new routing scenario 
 
 

 
Figure 5.4 zoom in on the A15 motorway exists. (a) Route 1 services both motorway exits, but (b) route 2 also services these 
arcs. Motorway exits indicated by the black arrows. 

 
 

    →                                    → 

A                B 
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Furthermore, taking a close look to the routing. Some nodes have been 
strangely serviced in order (figure 5.5). This is a sign that the 2-opt 
moving does not work perfectly, or that the tabu search has reached a 
suboptimum without considering these moves. Having these flaws does 
have negative influence on the routing. It is also impossible to modify 
the algorithm in order to change these obstacles. What will be done 
however is in each scenario try to eliminate some of the downsides of 
this scenario and aiming for routing which scores significantly lower in 
the total travel time. The next scenario, balancing, will try to account for 
routing which is more balanced and compact. This will now be explored. 
 
From a manual route making point of view one can point to many 
possible route flaws. Two things may be done to resolve this. One being 
that points can actually swap parts of the route, many arcs need to 
switch simultaneously. Also, the points are not pre-clustered. This 
makes the routing widespread. The next two scenarios are designed to anticipate to these design flaws. 
 

5.3 Sectoring  
With the help of administrative districts, the routes are categorised in sectors for creating more 
compact routes. Segments which fall outside the sector can still be included and are allocated to a 
nearby sector. Two sectors have been created, each for one route (figure 5.6, next page). The total 
travel time of the sectoring scenario is 214.55 (table 5.3), which costs 8.6% more travel time than the 
current routing. It is also higher than the new routing scenario, which has 208.25min (table 5.2). 
 
Table 5.3 Scenario 3: Sectoring  

 
Time route 1 

 
Time route 2 

      
Total 

Comparison 
Current routing 

Start time 00:00:00 00:00:00 
 

  
First service road arrival time 00:10:42 00:11:15 

 
  

Last service road departure time 01:51:22 01:19:24 
 

  
End time at depot 02:02:59 01:31:33 

 
      
  

Time from depot to first service road (min) 10.71 11.26 21.97 -5.7%  
Time from the last service road to depot (min) 11.61 12.14 23.75 -14.2%      

  
Service time (gritting) 54.45 32.24 86.68 -6.2%  
Deadhead time  18.11 15.57 33.68 143.8%  
Manoeuvre time 28.12 20.35 48.47 20.2%      

  
Number of left turns 53 37 90   
Left turns (min) 4.42 3.08 7.50 47.5%  
Number of U-turns 11 6 17   
U-turn (min) 5.5 3 8.5 112.5%  
Number of right turns 112 78 190   
Right-turn (min) 3.9 5.6 9.5 10.5%  
Number of straight across intersections 385 329 714   
Straight across intersections (min) 12.83 10.97 23.80 4.8% 
Manoeuvre error margin -0.23 -0.60 -0.83      

 

Total travel time (min) 122.99 91.56 214.55 8.6% 
Total distance (kilometres) 73.26 65.97 139.22 5.2% 

Figure 5.5 Not completed 2-opt move. 

An arc sequence 11-12-13, with node 

633 being serviced in between. 
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Figure 5.6 Gritting routes Hoogvliet in the sectoring scenario. 
 
The sectoring scenario performs quite poorly. The deadhead time is up by 243.8% in comparison to 
the current routing scenario (table 5.3, previous page). It also makes a lot of additional U-turns, 17 in 
total against 8 for the current routes. U-turns are considered to be undesirable. Even with an assigned 
30 second penalty for U-turns this scenario makes in total seventeen U-turns. Also the undesirable left 
turns are 47.5% more than the current routing scenario. Overall, it can be concluded that the sectoring 
scenario, as being proposed here, is considered sub-optimal at best. The combination of administrative 
districts did not propose sufficient routing. 
 
 
 
 
 
 
 
 
 
 



61 
 

5.4 Node reduction 
The node reduction scenario reduces nodes between two gritting route junctions. The results and 
routes are summarized (table 5.4 & figure 5.7, next page). The total gritting time consist of 186.34, 
which is 5.7% lower than the current gritting scenario. The decrease in total gritting time is significant. 
The total manoeuvre time also decreased (table 5.4). 
 

Table 5.4 Scenario 4: Node Reduction  
Time route 1 

 
Time route 2 

      
Total 

Comparison 
Current routing 

Start time 00:00:00 00:00:00 
 

 
First service road arrival time 00:10:34 00:11:08 

 
 

Last service road departure time 01:56:21 00:47:20 
 

 
End time at depot 02:07:50 00:58:30 

 
     
 

Time from depot to first service road (min) 10.57 11.14 21.71 -6.8% 
Time from the last service road to depot (min) 11.47 11.16 22.64 -18.2%     

 
Service time (gritting) 

75.56 27.88 103.45 
-2.6% 
 Deadhead time  

Manoeuvre time 30.23 8.32 38.55 -4.4%     
 

Number of left turns 57 21 78  
Left turns (min) 4.75 1.75 6.5 27.9% 
Number of U-turns 8 3 11  
U-turn (min) 4 1.5 5.5 37.5% 
Number of right turns 129 28 157  
Right-turn (min) 6.45 1.4 7.85 -8.7% 
Number of straight across intersections 456 130 586  
Straight across intersections (min) 15.20 4.33 19.53 -14.0% 
Manoeuvre error margin -0.17 -0.67 -0.83 -6.8% 

     
 

Total travel time (min) 127.84 58.50 186.34 -5.7% 
Total distance (kilometres) 76.78 51.45 128.23 -3.1% 

 

The disadvantage of the node reduction scenario is that not all required arcs are serviced. Nine sections 
in total have been neglected in the routing process (figure 5.7). The total loss of these sections is 
calculated to be 6.5 minutes (table 5.5). Adding these missed arcs the total travel time is recalculated 
to be 192.85, compared to 197.52 of the current routing scenario. This does not include manoeuvre 
time and additional deadhead time to reach the missing arcs. This reduces the total travel time to 
minutes or less and it can even be that the node reduction scenario performs worse than the current 
gritting scenario.  
 
Next, the route again has an increase in left turns and U-turns. Both turns are considered suboptimal 
for usage, because of the special manoeuvres it takes. Especially in winter times, when snow and ice 
can limit the drivers vision and making manoeuvre increases risk for traffic accidents. With manoeuvres 
to be added to this route, the amount of turns and thus left and U-turns will only increase. Also, the 
route is not compact. The second vehicle crosses almost every Hoogvliet neighbourhood.  
 
Table 5.5 Gritting times of missed arcs due to node reduction  

 Per side (min) Total (min) 

One sides 1.65 1.65 

Both sides 2.43 4.86 

Total missed arcs  6.51 minutes 
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Figure 5.7 Gritting routes Hoogvliet in the node reduction scenario 
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5.5 Overview routing 
The four scenarios were designed to analyse the routing algorithm on the gritting routes of Hoogvliet. 
The first scenario enabled us to capture data from the current routing. The other three scenarios were 
designed to test and modify the routing algorithm to outperform the manual made routes. The results 
are summarized (table 5.6). A single model run of all four scenarios gave a good indication on how the 
algorithm performed and what the major drawbacks are. These drawbacks are:  
 

i. Not all aspects of the current routing could be incorporated due to illegal vehicle manoeuvres. 
ii. The first vehicle seems to always fills vehicle one first. This leads to route imbalances in vehicle 

workload. 
iii. The swapping between vehicles seems to not work optimally. To counter this the node 

reduction scenario is calculated, but in this scenario not all required arcs are serviced. 
iv. Vehicles make additional turns compared to the current routing. Especially non-desirable turns 

as left turns and U-turns did increase most drastically. 
v. The node reduction scenario only outperformed the current routing. However, some arcs 

remained serviced. If these arcs are added to the total driving time, the difference to the 
current routing scenario is less than five minutes. This is excluding additional manoeuvres and 
deadhead. 

 
To interpret the results a critical reflection is given. This will go more in depth about the algorithmic 
performance and other issues regarding route modelling. This is discussed in the next chapter. 
 
Table 5.6 Overview routing scenarios  
  

scenario 1: 
current 
routing 

scenario 2: 
new routing 

scenario 3:  
districting 

scenario 4: node 
reduction* 

 
Travel time Travel 

time 
difference 
(%) 

Travel 
time 

difference 
(%) 

Travel 
time 

difference 
(%) 

Time from depot to first service 
road (min) 

23.31 21.97 -5.7% 
 

21.97 -5.7% 
 

21.71 -6.8% 
 

Time from the last service road to 
depot (min) 

27.67 24.65 -10.9% 
 

23.75 -14.2% 
 

22.64 -18.2% 
         

Service time (gritting) 92.42 86.68 -6.2% 86.68 -6.2% 
103.45 

-2.6% 
 Deadhead time  13.82 27.50 99.1% 33.68 143.8% 

Manoeuvre time 40.32 47.45 17.7% 48.47 20.2% 38.55 -4.4% 
        

Number of left turns 58 91 
 

90 
 

78 
 

Left turns (min) 5.08 7.58 49.2% 7.50 47.5% 6.5 27.9% 

Number of U-turns 8 14 
 

17 
 

11 
 

U-turn (min) 4 7 75.0% 8.5 112.5% 5.5 37.5% 

Number of right turns 172 193 
 

190 
 

157 
 

Right-turn (min) 8.6 9.65 12.2% 9.5 10.5% 7.85 -8.7% 

Number of straight across 
intersections 

681 730 
 

714 
 

586 
 

Straight across intersections (min) 22.70 24.33 7.2% 23.80 4.8% 19.53 -14.0% 

Manoeuvre error margin -0.23 -1.12 
 

-0.83 
 

-0.83 
 

        

Total travel time (min) 197.52 208.25 5.4% 214.55 8.6% 186.34 -5.7% 

Total distance (kilometres) 132.36 136.72 3.3% 139.22 5.2% 128.23 -3.1% 

* Not all required arcs are serviced in this scenario. 
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6. Discussion & future research 
 
The adaptation of a gritting routing model within a GIS is considered highly relevant, but still holds 
many limitations. These have been encountered and presented during this research. The following 
sections are devoted to discussing key findings and, where possible, to give directions towards further 
research areas and topics.  
 

6.1 Algorithmic optimization applicability & GIS Routing software  
At the centre of the routing model workflow is the used routing algorithms to solve the vehicle routing 
problem. Dealing with a rather large arc routing problem, it was not feasible to use exact algorithms 
in order to determine optimal routing scenarios. Instead, a metaheuristic tabu search algorithm is used 
which could provide near-optimal solutions for a large-sized problem, which included more complex 
constraints such as time-windows and turn restrictions. A literature review highlighted that almost no 
benchmarks studies exist to compare between own invented algorithmic solutions and manual routes 
in comparison to algorithms used by commercial GIS software vendors. This resulted into the analyses 
to insert two of the current manually created gritting routes of Hoogvliet in the routing model and next 
to compare this with vehicle routing algorithm of ArcGIS network analyst with the same routing 
restrictions.  
 
Results indicated that nor the new routing scenario, nor the districting scenario came close to the 
manually created routing in terms of total vehicle travel time. Even though in the current routing 
scenario more time is spent on deadheading than implicated and deadheading time increased by a 
factor two. In the node reduction scenario, this inefficient swapping of arcs was removed by minimizing 
nodes in order to traverse. Partially this solved the problem of those generating routes which 
contained too much deadhead, but as well generated the additional problem of not servicing a 
percentage of the arcs. It is reasonable to assume that there are multiple explanations for this 
outcome. 
 
On the technical side the routing algorithm is a black-box. The software supplier in charge often does 
not clearly state their solution methods, and these cannot be changed (Mapa & Lima, 2014: p. 845; 
Curtin et al., 2014). This also goes for the deployed GIS routing algorithm; it was known on forehand 
that the algorithm is built for vehicle routing problems but not for arc routing problems. The translation 
of arc routing into vehicle routing, has as a result that it is unknown if the algorithm handles this 
translation adequately. The algorithm is normally used to solve package delivery problems, instead of 
orders being densely placed within the network. This could, in the end, lead to inefficient algorithmic 
deployment.  
 
Ideally, one would like to modify the algorithm to see if this leads to better routing. There are many 
ways to accomplish this. Six points have been identified to tweak the tabu search algorithm to achieve 
better results, which are currently not possible and thus left unexplored. Insofar it is possible context 
is added which point in the direction found in the routing results. 
 
First, it is unclear how the initial solution is formulated. How exactly are the arcs (represented as nodes) 
assigned into the initial routing of vehicles and how does this effect routing outcome. Having the 
possibility to change this, might create completely new starting solutions and thus different points of 
departure of this optimization process. It is noticed during the creation of the route that the first one 
of two routes is always full of orders. This might be the result of that firstly the insertion algorithm fully 
fills the first route and only thereafter assigns remaining orders onto the second one. This balance 
remains throughout the swapping procedure, and it is rather unknown if this is efficient or that it is 
due to order insertion instructions. 
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Secondly, GIS does not give any insight into the solutions from the tabu list. This list keeps the history 
of recently considered candidate routing solutions, until these are refused (f.i. sufficiently far in the 
past) (Luke, 2015). The tabu list may indicate were exactly the algorithm is trapped in local optimum. 
So if a candidate solution performs worse than the current solution, these are still accepted and the 
algorithm is not permitted to hold on the current solution. Insight in the tabu list can be an input to 
define strategies, in order to optimize the usage of a different realm of the search space. As a result in 
the algorithm might come up with a better routing which minimizes overall driving time.  
 
Third, the length of the tabu list used (thetha) is unknown. It is however known that different values 
of thetha do indeed produce different routing outcomes (Krichen et al., 2014). Having a short tabu list 
leads to the algorithm get stuck in a local optimum, whereby a longer tabu list leads to longer 
processing time but does not ensures better routing outcomes.  
 
Fourth, the randomness of swaps like 2-opt, 2,5 opt and/or swaps between routing is unknown. 
Assigning different stochasticity on swapping procedures could utilize the search space in a different 
way. It is noticed that routes are ordinally ranked (vehicle 1, vehicle 2), with as a consequence that 
vehicle 1 receives more nodes to service. Not only could this procedure be built-in into the insertion 
of orders, but also into the stochasticity of swapping nodes. 
 
Fifth; invisibility of algorithmic calculations makes that one cannot check if the parameters which are 
set at the user input, are processed correctly. The user has no allowance to see if the algorithm uses 
time-windows and if it turns constraints properly in the route creation. In deploying routing 
technology, a difference became visible in the reported overall minutes between route information 
and underlying edge table. This difference is created due to additional time penalties in the turn 
restriction information of TomTom. There was no possibility to check which was the time used of the 
objective function to develop a routing solution. Dive into the algorithm is the best way to find this 
out. 
 
Sixth, the speed of the algorithm and the iterations per minute are unknown. No information is given 
if the algorithm is working efficiently. Information about this process could help with a couple of 
services. The algorithm for instance has a quite long processing time for a rather simple route. The new 
routing scenario takes 4.5 hours to calculate, while the districting scenario takes around 9 hours. There 
is no limitation of the searching time of the algorithm, nor does the algorithm provide information 
about the best solution found. It is also found that the solving time for the algorithm increases 
exponentially when adding additional nodes (Curtin et al., 2014: p.294). This makes it hard to scale the 
algorithm for taking on more routes. Next, ArcMap only uses 4gb of RAM for processing purposes, 
resulting in a slowing down of the algorithmic speed significantly.  
 
To solve the issues a modifiable routing algorithm should be developed, constructed to deal efficiently 
with arc routing, within a GIS environment. An exploration of software possibilities led to the 
conclusion that these initiatives are currently non-existent inside GIS software. However, some 
integration between GIS and routing algorithms have been successfully reported in literature. 
Kramberger et al. (2012) successfully reported an application in ArcGIS for a Chinese postman problem 
with priority routing. Krichen et al. (2014) uses an integration between CPLEX and QGIS to solve a 
vehicle routing problem and Hajibabai (2014) made a snow route optimizer plugin for ArcMap. None 
of these studies did share their source code and/or program, leaving the GIS community with a lack of 
usable optimization programs for GIS routing. A research direction could be the development of a tool 
for arc routing (in GIS), including access to the public, and creating the opportunity for the user to 
adjust the route optimization algorithm manually for rather technical parameters.  
 
A second strand of research could be devoted to create benchmarks for GIS routing problems. The only 
study which came near for the travelling salesman problem was published by Curtin et al. (2014). It 
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would be beneficial to produce similar studies for GIS vehicle routing or arc routing solutions. Lum 
(2018) recently released a tool for automatic creation of routing instances based on real network 
topology of OSM data, which could be used to create instances for comparison. Until now it is not 
conceivable to judge GIS routing algorithms on their performance, which makes it nearly impossible to 
choose a GIS program.   
 

6.2 Graph simplification & manipulation   
To calculate routes, a network dataset of TomTom Multinet is used in order to have a graph-based 
abstraction of the real-world road network. This network is loaded in ArcMap and used successfully to 
calculate routing. In applying the routing model to the Hoogvliet only suboptimal results have been 
achieved. Although not explicitly researched, routing outcomes suggest that the high number of 
traversed arcs is the cause of this problem. When reviewing the literature one finds evidence that the 
complexity of routing problems exponentially increases with the number of arcs or nodes added. 
Limiting the number of traversed arcs seems promising in reducing the complexity of the problem. To 
analyse this assumption a scenario is added whereby the nodes were reduced as much as possible. The 
passing arcs were dissolved and reconfigured according to their newly created nodes.  
 
Results of the graph simplifications clearly show that it reduces the total travel time significantly of 
vehicles by a substantial number. While the new route and districting scenario had an increase in total 
travel time, the node reduction scenario was the only one with less total travel time, when compared 
to the current routes. The method, however, has some drawbacks. The most important one is that 
routes do not automatically pass all required arcs. In the simplification process some arcs have been 
oversimplified, resulting in unreliable routes, which have to be manually adjusted and checked before 
considered valid. While some adjustments in the ability to pass arcs and increased penalty to U-turn 
vehicles is added, these instances still occur. Especially when the vehicle enters or exits a motorway 
inconceivable arc routing plays a role. 
 
To account for more realistic routing, measures have been taken which can negatively affect the 
routing. For instance, routes other than highways and local access roads are removed from the 
analysis, in order to ensure correct routing onto the nodes. Although this really helps, it implies that 
the network is limited in options and increases travel time of global optima, as well as result in arcs 
which cannot be fulfilled. For example, a one-way street where a U-turn is not allowed and the 
corresponding adjacent streets is marked as unpassable. Manually adding this to the route, together 
with adding arcs and turn movement needs to adjust the objective function. This is inconvenient, prone 
to errors in both the calculation of time and possibly violating turn constraints. 
  
Next to simplifying the graph to end up with more optimal routing results other graph manipulation 
techniques would be needed. The multiple passes problem, for instance, forces nodes to be used as 
ways to fill in arcs; one cannot place multiple nodes on a single arc. If the vehicle drives by, all the 
nodes will be filled. One way of resolving this issue is to create multiple arcs to the same junction 
nodes. Then, nodes can be placed on both arcs, representing the same street. Another issue is the 
creation of new roads, which is impossible at the moment. One would like to add roads at e.g. market 
places and/or squares. Here the vehicle can grit the market square at one end and drive to the street 
on the other side of the square. Unfortunately this option is not available at the moment.  
 
To the extent of discussing implications of results, and not being able to adopt this in the vehicle 
routing problem, is considered one of the biggest drawbacks. This scenario clearly shows a massive 
reduction in vehicle routing time. If it was possible to merge these arcs, reconfigure the network and 
inserting U-turns onto intersections. This would have been a massive improvement. Further research 
on finding ways to achieve this are warranted. Or built a completely new network, but somehow 
adding the TomTom data of the remaining parts back into the newly composed network. 
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6.3 Districting 
For the districting of Hoogvliet ten neighbourhood districts are used and divided into two sectors which 
respectively have been added to the vehicle routing problem. Results show that more compact and 
balanced routes are being produced, despite the fact that districting increases the total vehicle driving 
minutes. The districting protocol used allows us to create soft boundaries: if nodes are serviced by an 
adjacent sector this yields substantial benefits in driving time reduction. Next to an increase in total 
driving time a few points can be discussed by implementing the administrative districting procedure. 
 
Seeing the routing problem as a test for a broader application to the municipality of Rotterdam, some 
drawbacks are foreseen. While districting can help to deduce the vehicle routing problem complexity, 
districting also increases the solving time with a factor two. As it was impossible to solve the vehicle 
routing problem for the whole municipality of Rotterdam, districting would reproduce worse analyses. 
One would benefit that total solving time decreases rather than increases, especially when pre-set 
administrative boundaries are used in the route modelling algorithm. The same disadvantage applied 
to the insertion of route nodes. The route nodes are preferable placed to vehicles based on ordinal 
ranking. It seems that vehicle 1 is more likely to add orders to vehicle 2 then the reverse option. 
 
The assignment of districts was performed rather arbitrary, based on administrative boundaries. Those 
were subjectively chosen by the route designer to account for good routing. While there are solutions 
being proposed to find location allocation for arc routing problems, these problems are also NP-hard 
and not well researched in literature (Chen, 2017). No implementation of arc routing districting based 
on network characteristics was found for GIS systems. Providing an implementation for arc routing 
districting based on network characteristics in GIS would be an interesting topic for further research. 
 

6.4 Asset management data & digitisation 
The routing model workflow allowed the description of acquiring, cleaning and manipulating asset 
management network data. This aim was attained by transforming digitized lines in a GIS to an asset 
management dataset compatible to be added to a street network for routing purposes. Elaboration of 
these steps is described during the first four steps of the routing workflow methodology. In the pursuit 
of digitizing and transforming road asset management data several remarks can be made about data 
acquisition and processing.  
 
At the digitisation of the current gritting routes to TOP10NL road parts and later the transformation to 
the TomTom arcs many errors occur which need to be manually resolved After selecting categories 
within the dataset a subsection of wrongly selected parts still occurs, leading to manual resolvement, 
which in its turn may lead to human resolvement errors. Transforming the TOP10NL road parts to 
TomTom road segments inherits the same issues. Digitisation errors, again call for manual adjustments 
of relationships between asset classes. 
 
It can be augmented that storing of route attribute data into TOP10NL is aggregated too spatially. Data 
are not viewed on lane level, but rather as an aggregation of lanes. In transforming to TomTom 
midparts the TOP10NL crossroads are excluded from digitisation. These have not been digitised, 
including that information on crossroads is excluded in the analyses.  
 
Asset management data needs practical embedding within the organisation. The solution of asset 
management requires updating, and certainly not only rerouting, which requires people to manage 
those data. Due to data digitisation processes, which has many digitisation steps and is prone to errors, 
it might not be suitable to implement this within the organisation. A more simplistic approach could 
rather be implemented. This loss of perceived benefits of building an own data infrastructure will 
trade-off against user simplicity.  
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6.5 Route reporting & visualisation 
The use of vehicle routing gave the additional problem that the output generated was concerned by 
services nodes rather than arcs. Post-processing was required to recalculate route statistics and create 
route visualisation. While both route reporting and visualisation have been generated, some points 
are summed up which require attention. 
 
The original aim was to automatize the post-processing of route reporting by means of an ArcGIS 
ModelBuilder. As building of this model was stuck on some points, the aim had to be discarded. These 
problematic points being (i) the TomTom mismatched between total travel time reported in the total 
routing and generated traversed source features. This made joining of the two datasets very difficult 
Next, the (ii) generated output was delivered for all vehicles combined. It was not possible to iterate n 
vehicles for automated route reporting. Instead, Python scripts and manual steps were required to 
split the vehicles and processed them for each separate vehicle. Also, (iii) not all the wished data could 
be appropriately selected within the model. Difficult queries with travel times only found within the 
routing output where required to use as an input by the user. Then, the model (iv) the model executed 
badly and relations between processing steps were needed to be manually drafted each time the 
model ran. Lastly, (v) the overall model became too complex too many processing steps and joins were 
formulated into the model. Also, running the model took five minutes to process a single route report. 
This is not ideal for generating on-the-fly route statistics. 
 
These inconveniences led to a manual creation of route reports, which has some downfalls, in which 
there was room for manual digitisation errors and the route reporting could not been automatically 
written down. Some information could be derived from route output data provided by ArcMap, of 
which the most important one was the total travel time; this could easily be derived from the route 
statistics. To get more insight in routing and to get a better grasp on the routing, more statistics are 
required and controlled by the route maker. As it is easy to use but does not create most optimal 
routing performances. Important statistics as deadheading could not be derived, so not which roads 
where deadheaded and which were not; basic information when planning gritting routes. 
 
For route visualisation drawbacks were noticed as well. Like the automatization of route reports the 
automatization of map plotting is something not easily achieved in ArcGIS. Possibly it can be done by 
programming, there was no time left to undertake this issue. But for the manual plotting, some 
remarks could be made about the routing maps. Those maps are not very clear and although routes 
are plotted on both left and right side of roads, one cannot conclude how many times these routes 
pass this particular side of the road. Also the route connection on junctions is not clear. Ideally these 
maps should be created manually by cartographers. It is also impossible to see which parts of the road 
are considered deadhead and which ones are not. When more than one route is plotted on the map 
and they show some overlap, one has to choose one visible route, implying comparison of an integral 
routing plan will be difficult. A solution might be the use ArcGIS schematics and built rules or tools to 
automatically plot routes in such a way that these do not show any overlap. 
 
Although this point is worth noticing for route evaluation, itis less interesting for drivers which want 
to use route navigation and GPS technology in their car. It depends on the view of the organisation if 
paper maps are needed for backup, or that technology will slowly phase out or: erase paper route 
maps in a winter service organisation. 
 

6.6 Calculating network travel times 
TomTom Multinet data is used for the availability of reliable travel times, which is a key feature that 
open data sources such as OSM do not provide in a reliable way. Although the use of network travel 
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times is successfully applied in route modelling, some remarks can be made regarding the use of travel 
times in route calculation. 
 
Actually, it is unclear how the TomTom travel times are calculated. In the documents which were 
provided when achieving the network dataset no explanation on the calculation part was provided. 
This is in sharp contrast to the detailed way in which other features, such as network topology, are 
described in their user manual. The user has no other option than to trust the expertise of TomTom 
on information about travel times.  
 
Travel times themselves are also unreliable for the case of gritting. The speed of the TomTom Multinet 
dataset is used, but this is normally driven(used) by cars instead of gritting vehicles. A trial run on a 
winter service vehicle in Rotterdam revealed that regular maximum car speeds were reached driven 
by the drivers. This does not include the acceleration of the vehicle; this might affect the calculated 
travel time negatively. Some scholars therefore calculate different travel speeds for arcs which have 
already been gritted in comparison to arcs which need to be gritted (Holmberg, 2010: p.982). 
Differences also do exist in the use of assigning time to turn penalties. The turn penalties were already 
assigned by TomTom Multinet. However, this category was simplified, so not taking into account were 
differences in turning movement in combination with road hierarchies.  
 
To account for these changes two solutions are possible, both not yet investigated. These are is the 
performance of sensitivity analyses on the effect on parameters like travel time and turn movement 
time. Tweaking these parameters does provide insight in how these values create routes. Interesting 
results especially lie in penalizing U-turns and right turns, since these manoeuvres are not preferred. 
Another solution is to calibrate the model with the input of GPS data from actual gritting vehicles. This 
can shed light on the differences in travel time between the TomTom Multinet data and the situation 
outside. 
 
Travel times used are based on static information of giving only one travel time per arc. This is sufficient 
for calculating all routes but lacks realism in dynamic scenarios like traffic jams or poor weather 
conditions. Especially in these situations historical traffic data and/or adding spatiotemporal traffic 
data may help in creating more robust scenarios and thus routing. This allows the user to appropriately 
assign risk labels to routing being subject for large travel time differences. One may also notice that 
real-time traffic data sources are not included. Although placed outside the research scope in chapter 
one, this may adopt real-time information into other applications of the municipal winter service 
organisation. 
 
A last remark can be made about the external and internal revision rate of network data, which 
originate from 2014. To provide route makers with the most updated network information one must 
obtain an updated network dataset version and thereafter built a new version. The user must put his 
trust in the correctness of network topology and lane information. 
 

6.7 Routing characteristics  
At the identification of routing characteristics it became apparent that there are many factors to 
include into the routing model. To deliver more detailed work on the essentials of this model, some 
routing characterises have been excluded from research. Ideally, they would be included in the final 
route model workflow. Three main characteristics will be briefly discussed: salt usage, lane 
prioritization and the adding of bike lanes. 
 
The most conspicuous of the missing routing characteristics was not taking salt usage into account. 
The motivation was twofold: the task had been assigned within the municipality to another colleague 
and in conversations with the winter service section the level of salt use does not seem to be of critical 
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importance. The vehicles are already time bounded and did not need to refill within this time window. 
For the analyses, however, this implies that the exclusion of factors simplified the model. But in the 
next phases of the WINTER project the calculation of salt usage is formulated as a goal itself. The 
current asset management data approach of TOP10NL data can give a rough estimation of salt usage, 
but might fail in precisely measuring salt usage, something to keep in mind for later stages of the 
WINTER project.  
 
Many routing models do take route prioritisation into account when formulating routes. Within the 
municipality of Rotterdam the most critical infrastructure was already placed within an access route 
category. The access routes contained all roads which included many of the points which needed fast 
gritting, e.g. bridges and other critical infrastructure and frost spots. In the calculation on roads of 
secondary importance it is advisable to insert roads prioritization. One examples is the gritting of main 
routes first in certain sectors before moving into residential areas. The vehicle problem solver of ArcGIS 
does allow route prioritization. Using these options affect the routing outcome and it negatively affects 
the calculation time of routes, which is not researched and thus unknown. 
 
Last, the dataset does not contain bike lanes, so it is completely unknown if routing work adequate on 
bike lanes. And on top, these bike lanes are used by different vehicles. Again, characteristics are 
unknown of routing these specific vehicles. The network dataset did not contain bike roads either, and 
it is therefore unknown if TomTom can deliver these data, not its quality and if the routing works 
properly using the same route modelling workflow which is created for route modelling gritting 
vehicles. 
 

6.8 Route updating procedure 
The routing model workflow creates static routing by using geographical information management 
software. While routing can be calculated and implemented the network design of Rotterdam is 
temporal and it changes continually. Currently all routes are revised annually by cartographers. 
Adopting a routing model would suggest a different update procedure and its model should be rerun 
to detect if the renewed road network could be used in the same manner, or that time saving measures 
can be implemented. However, adopting route modelling and rerunning takes personnel specialized 
in network modelling, and on top GIS network analyses knowledge is not a standard skill. Ideally, 
specialists need to join the organisation for many years in order to keep knowledge within the 
organisation. Not understanding route modelling could cause human errors in the route modelling 
process, which in its turn can lead to significant delays. 
 
As pointed out earlier, the internal and external revision rate of network data is important for the 
update frequency. Route network datasets can become out-of-date; software renewal leads to new 
versions. Updating routing is not only needed in the current dataset, but routes need to be digitised 
as well in the new one. All these operations are very time costly and GIS network analytics skills are 
required. This together is far more difficult than the current practice of updating routes by drawing 
lines.  
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7. Conclusion & Recommendations 
 
 

7.1 Conclusion 
A conclusion summarizes the total content of this thesis. An answer will be given to the five sub 
research questions and subsequently the main research question will be answered. 
 
1: How is the current gritting of roads organised? 
The current gritting roads responsibilities are assigned to the winter service organisation (chapter 2). 
These take care of all operations for network design, transportation management, staff management 
and inventory control. The winter service organisation must compel to the road law to provide safe 
travel for all road users. The most important requirement is a two-hour time window for municipal 
roads in poor weather conditions but is retained in all routing situations. Salt capacity on vehicles is 
however not seen as a constraining factor. 
 
The municipal gritting routes for motorways are divided into two categories: access routes and other 
main motorway routes. Access routes consist of critical infrastructure and frosty spots. To identify 
gritting routes multiple criteria are used, amongst them main motorway roads, access roads, bus lanes, 
P&R locations, shopping areas and calamity routes for hospitals, ambulance and police personnel, and 
fire stations (chapter 2.4). Two routes gritted scenarios exist: only grit access routes or grit every route. 
Which routing scenario is executed depends on the weather forecast. All routes are created and 
adjustments are manually drafted by in-house cartographers.  
 
2: Which characteristics are considered relevant for modelling gritting routes? 
Six characteristics have been distinguished which are considered relevant:  transportation network, 
road segments, sectors, vehicle & depots, routes & drivers and route objectives (chapter 3.2). These 
characteristics suit the problem description, whereby four elements are described which are needed 
for this routing problem:(i) the use of heterogeneous vehicles, (ii) multiple depots locations, (iii) graph 
representation of a transportation network with one-way and two-way streets to be serviced and (iv) 
not every road segment may need to be serviced. Together with the characteristic of the (v) two hour-
time window in the previous chapter these make up the most important requirements. 
 
The other important characteristic is the modelling approach choice; the one chosen is the vehicle 
routing problem with a time-window (chapter 3.3). The vehicle routing problem includes algorithms 
which are well studied and integrated within most commercial GIS software (chapter 3.4-3.5). Routing 
model characteristics have been summarized and their relationships have been defined in the 
conceptual model (chapter 3.6). 
 
Sub question 3: How can these characteristics be incorporated into a routing model? 
The characteristics of the conceptual model have been translated into a GIS routing model workflow 
(chapter 4.4). Thirteen phases have been distinguished, ranging from the creation of the network 
dataset to visualise the staff routing output. The routing model begins with a process for acquiring, 
cleaning and manipulation asset management network data, defined in data input and pre-processing 
stage of the GIS routing model workflow. At the core the routes are formulated using the vehicle 
routing solver of ArcGIS network analyst, which uses a meta-heuristic tabu search based algorithm. 
The routing output is then generated and tweaked to represent arc traversals of gritting vehicles. In 
the routing model workflow, a possibility is added that some of the data input and parameters can be 
changed throughout the process.  
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Sub question 4: How does the routing model perform regarding the decrease of driving time? 
To evaluate the performance two current gritting routes of Hoogvliet have been added to the routing 
model. Results have been compared and three scenarios are suggested: a new routing scenario, a 
districting and node reduction scenario. The new routing and districting scenario had an increase in 
total vehicle travel time of 5.4 % and 8.6%. The node reduction scenario did outperform the current 
gritting routes by 5.3% but did leave some arcs ungritted and unconnected inside the routing (chapter 
5.5). 
 
The model did a run with 904 service nodes in the new scenario and districting scenario. In the node 
reduction scenario, a total of 280 nodes are serviced. The solving time for the scenarios is between 1.5 
and 9 hours. 
 
Sub question 5: To what extent can the GIS routing model be implemented within the organisation? 
Although the routing model can be used to decrease driving time, it was tested at only two gritting 
roads in Hoogvliet. For implementation the routing calculations have to scale to 30 main gritting 
routes. To implement some issues remain on both technical and organisational issues (chapter 6.1). 
The algorithm is not specially designed for large arc routing problems and has poor performance both 
in speed & accuracy. Districting is necessary to account for these issues. Furthermore, the network 
dataset cannot be simplified to reduce model solving complexity. From an organisation perspective, 
routing is labour intensive and quite specific. If one wants to proceed in recalculate the routing just 
once, one may want to consider these points before adopting a GIS routing model within the 
organisation.  
 
The five sub questions have been answered. Now the main questions will be answered: 
 
Main research question: To what extent can the adaptation of a routing model decrease the driving 
time of gritting vehicles in the municipality of Rotterdam? 
 
This thesis was concerned with creating a route modelling workflow to calculate the total travel time 
of gritting vehicles. It is shown for two routes at Hoogvliet that the routing model, using a tabu search 
algorithm of ArcGIS, can decease total travel time for 5.3% percent in the node reduction scenario. 
However, the model did leave some arcs ungritted and unconnected in the routing. Manual 
reconfiguration of routing is required to create sufficient routing, which also increases the total travel 
time. 
 
In the routing process some characteristics could not be properly modelled. The road network could 
not be modified. This meant that the graph could not be simplified correctly, which gave algorithmic 
problems and unfinished routing. A not modifiable graph also meant that the network could not be 
expanded with additional roads and that multiple passing of one road was not possible to model. 
Furthermore the algorithmic performance was is considered both poor on speed and accuracy. Lastly, 
the routing is labour intensive and quite specific.  
 
Overall the chosen approach is considered not sufficient for adopting in a large municipality. The factor 
of improvement is considered low for adopting the proposed route creation modelling workflow. 
Furthermore, issues regarding the graph simplification, algorithmic performance and organisation 
implementation should be resolved before adapting a winter service vehicle routing model. 
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7.2 Recommendations for the municipality of Rotterdam 
To accompany the municipality of Rotterdam in the process of automatizing the ICT of gritting 
operations four recommendations are formulated. 
 

i) Obtain or outsource the GIS software infrastructure to adequately solve the formulated 
winter service (arc) routing problem 
Solving large winter gritting arc routing problems is too difficult using the ArcGIS tabu 
search algorithm for vehicle routing problems. A different GIS software architecture is 
required which is considered a niche market in routing software. Most winter service 
routing problem formulations focus on salt capacity limits for vehicles, while in the case of 
Rotterdam time window violations is the main limitation for modelling. In the software 
exploration (chapter 4.3) a company called RouteSmart offers specialized arc routing 
software as a plugin for ArcGIS and offer help with route formulation. It might be beneficial 
to explore this as an option and/or to seek to team up with external parties specialized in 
arc routing. 

 
ii) A combination of routing software and hands-on knowledge is always needed 

Routing software cannot automate everything. It is always a synergy between the route 
software and route makers. Also, due the complex nature of the optimization suboptimal 
routing is created. Rerunning the model several times may result in better routing. Also 
changing parameters like constraints, districts and speed limits may generate different 
routes. Route creation is an iterative process which require devoted attention by users.  

 
iii) Create a storage for winter service asset management data 

Th current gritting routes are stored as digitized lines within a database. There is no spatial 
data infrastructure set up for gritting operations. It would be recommended to create a 
basic information storage infrastructure for gritting data. Preferably in corporation with 
the road authority. The setting up of this infrastructure is dependent on the chosen 
software architecture. This thesis uses TomTom data for linking asset management data, 
but routing software vendors use different commercial network datasets. First define the 
GIS software before one set up the winter service asset management data storage.  

 
iv) Embed the new route updating within the organisation  

The route update is done by manually drawing routes. With a new system the updating 
process will likely change to digital updating in different software and later on navigation 
systems. Do not underestimate the time it cost to develop new routing for these vehicles 
and modifications it takes to develop good routing in the first years of operation. This point 
also includes holding the network data to a constant quality standard and check for 
network updates. 
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Appendix A: Gritting Routes HR_044 and HR_045 
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Appendix B: TomTom Multinet  UML Relationship model    
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Appendix C: Routing workflow processing steps ArcMap 
 
 
For the routing workflow ArcMap is used. This appendix described the processing steps of each of the 
phases of the routing workflow which is described at p. 42. The phases are listed in in table Ac.1  
 
Table Ac.1 Phases of the routing workflow 

i Create network dataset Adding TomTom network in ArcGIS format 

A Digitisation The translation from digitised lines into TOP10NL road parts 

C Transformation Transforming the TOP10NL road parts to (TomTom) road segments 

D Arc to node routing Creating nodes from arcs 

 

Colour scheme used in this workflow process: 
Underlined   Instructions for manual processing steps 
In Italic Green  SQL expressions 
Blue Underlined Download link for online toolboxes 
   Clickable action 
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Phase i: TomTom network Rotterdam 
This section describes the correct transformation of the TomTom network dataset into a compatible 
ESRI ArcMap format. This preliminary step has to be done manually before creating the routing 
model. 
 
The delivered TomTom network dataset is already set to the RD_New coordinate system (directory: 
…Netwerkdata_TomTom/RDNew). If a new version is acquired and used, make sure to adjust the 
coordinate system to RD_New.  
 
Download the Street data processing toolbox 

1. Download the Street data processing toolbox from  
https://github.com/Esri/street-data-processing-tools/releases 

2. Install the appropriate version according to the guidelines (for ArcMap 10.3.1, download the 
Street Data Processing Tools v10.3.1.2). 

3. Open the .zip file and copy the toolbox to a file directory and follow the instructions as 
described on GitHub. 

 
Transforming the TomTom network dataset in a compatible ESRI ArcMap format 

4. Open ArcMap and go to Geoprocessing -> ArcToolbox 
5. Right click the ArcToolbox and click on Add Toolbox. Add the Street data processing toolbox 

which you unzipped. 
6. Open data Street data Processing Tools -> TomTom -> Process MultiNet Street data which 

should be added to the ArcToolbox.  
7. Add the NW, MN, MP, SI, SP and RS table from the …Netwerkdata_TomTom/RDNew 

directory. Check the ‘Create Network Attributs in Metric (optional)’ button. 
8. Click on Ok. The network dataset is created.  

 
Clipping the network to Rotterdam 
The network will be clipped to the municipality of Rotterdam, to reduce loading time. 

9. Open the ‘Distributed Geodatabase’ toolbar. 
10. Click the ‘’Extract Data’ button. 
11. Check the box ‘Show advanced options for overriding data extraction defaults’ 
12. For the spatial extent of the municipality of Rotterdam, use the following extent: 

Display extent: 
Left:     52580 
Right:   105100 
Top:   450777 
Bottom:  425873 
Include all the items for the extraction. 

13. Click next, and check the box for ‘require no further action’. 
14. Save the created network dataset. 

 
Building the network dataset 

15. Go to the Arc Toolbox -> Network Analyst Tools -> Network Dataset -> Build Network 
16. Choose the ‘Routing_ND’ as input for the network dataset and click OK. 

 
Output 0: The TomTom is now loaded in ArcMap for the municipality of Rotterdam in an ESRI 
network dataset format. 
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Phase A: Digitization  
In this section the digitized lines are transformed to the correct TOP10NL road parts. Steps 1-6 are 
automated in ArcMap using the model builder. Step 7-12 are manually steps. 
 
Joining line attributes to TOP10NL road parts 

1. In ArcMap, click ‘File -> Add Data -> Add data’ and add the Roadpart_polygon and 
GrittingRoutes_HR to the map. 

2. At Selection, click on ‘Select By Location.’ Use the ‘select features from’ selection method. 
Select ‘Roadpart_polygon’ as the target layer and ‘GrittingRoutes_HR’ as the target layer. 

3. Click Ok. The attribute table of the GrittingRoutes_HR is now joined to the Roadpart_polygon 
dataset based on location. 

 
Automatic road part selection based on relevant attributes 
Not all road parts selected by the use of location are relevant. To account for this a selection is made 
based on attribute characteristics, such as traffic use and road type. 

4. Open the Select (Analyses) Tool. Use the output of step 3 as input, and use the SQL 
Expression routenummer = 'HR044' OR routenummer = 'HR045'.  

5. Open the Select (Analyses) Tool. Use the output of step 4 as input, and use the SQL 
Expression: HOOFDVERKEERSGEBRUIK_CSV = 'busverkeer' OR HOOFDVERKEERSGEBRUIK_CSV 
= 'busverkeer|fietsers, bromfietsers' OR HOOFDVERKEERSGEBRUIK_CSV = 'gemengd verkeer' 
OR HOOFDVERKEERSGEBRUIK_CSV = 'gemengd verkeer|busverkeer' OR 
HOOFDVERKEERSGEBRUIK_CSV = 'gemengd verkeer|fietsers, bromfietsers' OR 
HOOFDVERKEERSGEBRUIK_CSV = 'gemengd verkeer|voetgangers' OR 
HOOFDVERKEERSGEBRUIK_CSV = 'snelverkeer|gemengd verkeer' 

6. Open the Select (Analyses) Tool. Use the output of step 5 as input, and use the SQL 
Expression: TYPEWEG_1 = 'hoofdweg' OR TYPEWEG_1 = 'lokale weg' OR TYPEWEG_1 = 
'overig' OR TYPEWEG_1 = 'regionale weg' OR TYPEWEG_1 = 'straat'. 

 
Manual road part selection 
Based on both spatial and functional selection still some road parts are wrongly digitized or not 
selected. This check has to be done manually. 

7. At selection, click on ‘Select By Attributes’. Use the ‘Strooiroutes_HR” layer and use method: 
create a new selection with the SQL Expression: routenummer = 'HR044' OR routenummer = 
'HR045' 

8. Compare the digitized lines (step 7) with the TOP10NL road parts (step 6).  
If the gritting routes are correctly digitized to road parts, save the output (step 12) 
If there are road parts which are should not be in the road parts selection (step 9 & 12) 
If road parts still need to be included in the road parts selection (Step 10-12) 

9. Use the ‘select features’ button and select the irrelevant road parts. After selection,  
right click the layer Road part layer and ‘open attribute table’. At the table, switch the 

selection  . Close the attribute table and right click the road part layer and Select 
‘selection -> Create layer from selected features. 

10. Use the road part input data (step 1) to select the missing road parts with the ‘select 

features’ button. If all missing road parts are selected, right click on the layer and use 
‘Selection -> Create layer from selected features’. 

11. Go to Geoprocessing -> Merge. Use the Road parts (from either step 8 or 9) with the 
additional road parts which are selected in step 10. Select OK.  

12. Save the layer output using ‘Data -> Export data’. 
 
Output A: A dataset containing all relevant TOP0NL road parts with a joined attribute table from the 
original gritting routes.  
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Phase C: Transformation  
The next step consists of selecting the correct TomTom street segments and convert these street 
segments into mid points. This will enable the use of network analyses. Part 1. Steps 1-3 are 
automated in ArcMap using the model builder.  Step 4-13 will have to be done manually. 
 
Select TomTom street segments 

1. In ArcMap, click ‘File -> Add Data -> Add data’ and add the TOP10NL Road parts dataset as of 
the output of Section A: Digitization. Furthermore, add the network dataset as created in 
Appendix 0: TomTom network Rotterdam. 

2. Go to ‘Selection -> Select by location’.  Use the ‘select features from’ selection method with 
the ‘Streets’ as Target Layer and the TOP10NL Road parts dataset as source layer. 

3. Right click on the Streets layer and Select ‘selection -> Create layer from selected features. 
Export the data from the newly created layer by right click the layer and go to ‘data -> Export 
data. Click ‘yes’ for ‘Do you want to add the exported data to the map as a layer?’. This 
allows the user for not editing the network dataset, but instead using it as an alternative 
dataset. 

 
Manual TomTom line segment selection 
The TOP10NL Roadparts should match the TomTom line segments. However, due to the spatial 
selection some parts are either wrongly selected or not selected at all. To adjust for these digitization 
errors additional manual steps are required. 

If there are TomTom street segments which are should not be in the selection (step 4 & 7) 
If TomTom line segments need to be included in the selection (Step 5-7) 

4. Use the ‘select features’ button and select the irrelevant road parts. After selection,  
right click the layer Road part layer and ‘open attribute table’. At the table, switch the 

selection  . Close the attribute table and right click the road part layer and Select 
‘selection -> Create layer from selected features. 

5. Use the TomTom network dataset as input data (step 1) to select the missing road parts with 

the ‘select features’ button. If all missing road parts are selected, right click on the layer 
and use ‘Selection -> Create layer from selected features’. 

6. Go to Geoprocessing -> Merge. Use the Road parts (step 4) with the additional road parts 
which are selected in step 5. Select OK.  

7. Save the layer output using ‘Data -> Export data’. 
 
Create TomTom line segment midpoints 

8. Download the ET GeoWizard 11.4 tool for ArcGIS 10.3 at http://www.ian-
ko.com/Downloads.html 

9. Open the .zip file and follow the setup instructions from the installation. You might have to 
restart ArcMap in order to use the functionalities. 

10. Go to Customize -> Toolbars ->  ET Geowizards. An additional window will open  
11. Click on the logo and go to Convert -> Polyline to point. Click on ‘Go’. Select the polyline layer 

which you created (step 7) and specify the output feature class. 
12. Click on next and specify the ‘Middle Points’ conversion option. Uncheck all the boxes and hit 

‘Finish’. 
13. Right click on the newly created middle point layer and save the output using ‘Data -> Export 

Data’. 
 
Output C: In this section two output layers are created: (i) the TomTom Line segments and (ii) the 
TomTom Line segments midpoints. 
 
  

http://www.ian-ko.com/Downloads.html
http://www.ian-ko.com/Downloads.html


87 
 

Phase D: Arc to node routing and attribute transfer (part 1) 
Part one consists of matching the  TOP10NL road parts to the correct TomTom midpoints. Step 1-10 
and 14-16 have been created in ArcMap Model builder. Steps 11-13 and 17-19 will have to be done 
manually. 
 
Select TOP10NL road links & convert to points 

1. In ArcMap, click ‘File -> Add Data -> Add data’ and add the TOP10NL Road parts dataset as of 
the output of Section A: Digitization. Furthermore, add the TomTom point dataset as created 
in Appendix C:Arc to Node routing. 

2. Go to ‘Selection -> Select by attributes’.  Use the ‘TOP10NL Road parts dataset as layer and 
choose ‘Create a new selection’ method. For this use the SQL expression: typeInfrastructuur 
= 'verbinding'. Click ‘Ok’. 

3. Convert these road inks to points with the Feature To Point (Data Management) tool. This 
will make one point from the polygon objects. 

4. Add XY coordinates to these point objects with the Add XY Coordinates (Data Management)  
tool. These coordinates are needed in a later stage. 

5. Use the near (Analyses) tool to identify the nearest TomTom points to the TOP10NL road 
part points. Use the ‘TomTom mid points’ as input features and the ‘Top10NL road part (as 
created in step 2) as near feature. This step will create an attribute called ‘NEAR_FID’, which 
indicates the nearest TomTom mid point to the TOP10NL road parts. 

 
Create connection links between TOP10NL road links and TomTom midpoints 

6. Open the Join Field (Data Management) tool. Use the TomTom mid points (step 5) as input 
table. The input join field is the ‘NEAR_FID’. Use the  TOP10NL road part points (step 4) as 
join table. Use the OBJECTID as Output join field. 

7. For now the joining of these tables give a lot of additional attributes which are not of interest 
yet. Use the Delete Field (Data Management) tool to remove these. Delete all attributes 
except for: ET_X , ET_Y (the coordinates of the TomTom midpoints), NEAR_FID (indication 
nearest TomTom midpoint) and POINT_X and Point_Y (coordinates top10nl road part point). 

8. Right click the layer TomTom mid points and ‘open attribute table’. At the table, click table 
options and choose ‘Add Field…’. Name the field ‘IDroadpartchange’ and keep the data type 
a short integer. Click ‘Ok’. 

9. Select the newly made IDroadpartchange row, right click and hit ‘Field Calculator’. For the 
expression, use: [NEAR_FID]. This will make a copy of the NEAR_FID to the IDroadpartchange 
field. This field will be used later. 

10. Use the ‘XY To line’ tool. Use ET_X and ET_Y as start fields and Point_X and Point_Y as End 
fields. These lines graphically indicate the relation between the tomtom lines and road part 
polygons, in a simplified point-line-point view. 

 
Manual near check (1) 
The output created gives a visual overview of which TOP10NL road parts are connected to which 
TomTom lines. This connection has to be check manually. In case if there are wrong connections 
made: 

11. Go to Customize -> Toolbars -> Editor. Right Click on Editor in the Editor menu and hit ‘Start 
Editing’. Choose the ‘TomTom midpoints’ layer for editing. 

12. Right click the layer TomTom mid points and ‘open attribute table’. At the table, go to the 
IDroadpartchange field. In this field, change any of the wrongly assumed connections by 
changing the ID to the correct connection. 

13. If all the connections have been updated, go to the editor menu and save the edits. After 
saving, stop the edit session. 
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Manual near check (2) 
In the previous step 13 the connections have been updated. In this manual near check it is looked if 
the  connections are updated correctly.  
 

14. Open the Join Field (Data Management) tool. Use the TomTom mid points (step 13) as input 
table. The input join field is the ‘IDroadpartchange’. Use the  TOP10NL road part points (step 
4) as join table. Use the OBJECTID as Output join field.  

15. Again, this join gives additional attributes which are not of interest in this stage of the 
process. For this the Delete Field (Data Mangement) is used to remove these. Only keep the 
attributes ET_X, ET_Y (the coordinates of the TomTom midpoints), NEAR_FID and 
Idroadpartchange (indication nearest TomTom midpoint) and POINT_X_1 and Point_Y_1 
(coordinates top10nl road part point). Make sure to delete the POINT_X and POINT_Y 
coordinates. These belong to the previous manual near check. 

16. Use the ‘XY To line’ tool. Use ET_X and ET_Y as start fields and Point_X_1 and Point_Y_1 as 
End fields. These lines graphically indicate the relation between the TomTom lines and road 
part polygons, in a simplified point-line-point view. 

17. Check if the updated points and lines are correct. If this is still not the case, repeat steps 11-
13. In case there are still many connections made wrong, a second manual near check can be 
executed as described in steps 14-16. 

 
Transferring attributes TOP10NL to TomTom midpoints 
The next steps encompass the attribute transfer from the TOP10NL road parts to the TomTom 
midpoints. For this the TOP10NL ID is used as the ID as the connector. 

18. Open the Join Field (Data Management) Tool. Use the TomTom mid points (step 14) as input 
table. The input join field is the ‘IDroadpartchange’. Use the  TOP10NL road part points (step 
4) as join table. Use the OBJECTID as Output join field. 

19. If the join is successfully, the attribute data which was needed to ensure the correct join can 
be removed. These attributes are: ET_X, ET_Y, NEAR_FID, Point_X(_1) and Point_Y(_1). Keep 
the attribute of IDroadpartchange. If the user do not wish to remove these attributes, they 
might be hided in the attribute table as well using ‘Turn field off ‘ option. 

 
Output D (part 1): All the TomTom lines via a TomTom midpoint have been assigned to the correct 
TOP10NL road part. Furthermore the attribute data of the TOP10NL has been transferred. Any 
additional data which the user wants to add later can be easily joined with the use of the TOP10NL 
ID. Additionally, in model builder some additional layout is added with the use of the ‘make feature 
layer’ and ‘apply symbology from layer’ tools and .lyr layout inputs. 
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Phase D: Arc to node routing and attribute transfer (part 2) 
In appendix D (part 1) all the TOP10NL road parts have been assigned to the correct TomTom 
midpoints. In part 2 the remaining a TOP10NL road part, which have not been assigned to a TomTom 
mid point yet, will be joined. 
 

1. In ArcMap, click ‘File -> Add Data -> Add data’ and add the TomTom midpoint dataset as the 
output of Appendix D1: Attribute transfer (part 1). Also add the road part dataset without 
the junctions in points as selected in Appendix D1: Attribute transfer (part 1), step 3. 

2. Open the Join Field (Data Management) tool. Use the TomTom mid points as input table. The 
input join field is the ‘IDlokaal’. Use the output of Appendix D1: Attribute transfer (part 1) as 
join table. Use the IDlokaal as Output join field. 

3. At selection, click on ‘Select By Attributes’. Use the ‘TomTom mid point” layer and use 
method: create a new selection with the SQL Expression:  IDroadpartchange > 0. 

4. Use the Erase (Analyses) tool. Take the road part dataset without junctions as input dataset 
and the TomTom mid point selection (step 3) as erase feature. 

5. Take the output of step 4 and add  XY coordinates (Data Management).  
 
Create connection links between the remaining TOP10NL road links and TomTom midpoints 

6. Click ‘File-> Add data -> Add data’ and add the TomTom midpoints as created in Output C. 
7. Use the near (Analyses) tool to identify the nearest TomTom points to the TOP10NL road 

part points. Use the ‘TomTom mid points’ from output C as input features and the ‘Top10NL 
road part point features (as created in step 5) as near feature. This step will create an 
attribute called ‘NEAR_FID’, which indicates the nearest TomTom mid point to the TOP10NL 
road parts points. 

8. Right click the layer TomTom mid points and ‘open attribute table’. At the table, click table 
options and choose ‘Add Field…’. Name the field ‘IDtomtomchange’ and keep the data type a 
short integer. Click ‘Ok’. 

9. Select the newly made IDtomtomchange row, right click and hit ‘Field Calculator’. For the 
expression, use: [NEAR_FID]. This will make a copy of the NEAR_FID to the IDtomtomchange 
field. This field will be used later. 

10. Use the ‘XY To line’ tool. Use Point_X and Point_Y as start fields and Near_X and Near_Y as 
End fields. These lines graphically indicate the relation between the remaining TomTom 
points and road part polygons, in a simplified point-line-point view. 

 
Manual near check (3) 
The output created gives a visual overview of which the remaining TOP10NL road parts are 
connected to which TomTom lines. This connection has to be check manually. In case if there are 
wrong connections made: 

11. Go to Customize -> Toolbars -> Editor. Right Click on Editor in the Editor menu and hit ‘Start 
Editing’. Choose the ‘TOP10NL road part point’  layer (step 8) for editing. 

12. Right click the layer TomTom mid points and ‘open attribute table’. At the table, go to the 
IDtomtomchange field. In this field, change any of the wrongly assumed connections by 
changing the ID to the correct connection. 

13. If all the connections have been updated, go to the editor menu and save the edits. After 
saving, stop the edit session. 

 
Manual near check (4) 
In the previous step 13 the connections have been updated. In this manual near check it is looked if 
the  connections are updated correctly.  
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14. Open the Join Field (Data Management) tool. Use the TOP10NL road part points (step  14) as 
input table. The input join field is the ‘IDtomtomtchange’. Use the TomTom mid points (step 
13) as join table. Use the OBJECTID as Output join field.  

15. Again, this join gives additional attributes which are not of interest in this stage of the 
process. For this the Delete Field (Data Mangement) is used to remove these. Only keep the 
attributes ET_X, ET_Y (the coordinates of the TomTom midpoints), NEAR_FID and 
IDtomtomchange (indication nearest TomTom midpoint) and POINT_X_1 and Point_Y_1 
(coordinates top10nl road part point). Make sure to delete the POINT_X and POINT_Y 
coordinates. These belong to the previous manual near check. 

16. Use the ‘XY To line’ tool. Use ET_X and ET_Y as start fields and Point_X_1 and Point_Y_1 as 
End fields. These lines graphically indicate the relation between the TomTom lines and road 
part polygons, in a simplified point-line-point view. 

17. Check if the updated points and lines are correct. If this is still not the case, repeat steps 11-
13. In case there are still many connections made wrong, a second manual near check can be 
executed as described in steps 14-16. 

 
Transferring attributes TOP10NL to TomTom midpoints 
The next steps encompass the attribute transfer from the remaining TOP10NL road parts to the 
TomTom midpoints. 

18. Open the ArcGIS catalog window and go to the active file geodatabase were the TOP10NL 
road parts and the TomTom midpoints are stored. It is important that these files are active in 
the same geodatatabase.  

19. Right click on the file geodatabase, select ‘New’ and click Relationship class. Choose the 
remaining TOP10NL roadparts as Original table/feature class and the TomTom midpoints as 
destination table/feature class. Give the relationship class the name ‘Remaining_road_parts’ 
Click next.   

20. Choose the following settings: the type of relationship is‘Simple (peer to peer) relationship’, 
The messages direction is ‘None (no messages propagated), the cardinality is 1 - M (one to 
many), Choose ‘No’, at the option to choose addtributes to this relationship class. 

21. At the Origin table/feature class, the Primary key is OBJECTID and the Foreign key is 
IDroadpartchange. For the Destination table is still the TomTom midpoints. Click ok. A new 
relationship class is made within the geodatabase 

22. To show the table relationship, open the attribute table of the TomTom mid points and click 

on related tables . 
 
Output D (part 2): All the remaining TOP10NL road parts have been assigned to the correct TomTom 
midpoint. Furthermore the attribute data of the TOP10NL has been transferred. Any additional data 
which the user wants to add later can be easily joined with the use of the TOP10NL ID. Additionally, 
in model builder some additional layout is added with the use of the ‘make feature layer’ and ‘apply 
symbology from layer’ tools and .lyr layout inputs. 
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Appendix D: Traversing arcs Hoogvliet 
 

 

 

 
  

Figure Ad.1 Overview map of arcs subject to gritting in Hoogvliet 

Scale: 1:25,000 

Overview map arcs subject to gritting in Hoogvliet, Rotterdam 

Coordinate system: RD New 
Projection: Double Stereographic 
Datum: Amersfoort 

Source:  TomTom Multinet (2014) 
 Municipality of Rotterdam (2013) 
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